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Digital TV Notice
1.  Functionalities related to Digital TV(DVB) are only available in countries/areas where DVB-T (MPEG2 and MPEG4 AVC) digital 

terrestrial signals are broadcasted or where you are able to access to a compatible DVB-C(MPEG2 and MPEG4 AAC) cable-
TV service. Please check with your local dealer the possibility to receive DVB-T or DVB-C signal.

2.  DVB-T is the DVB European consortium standard for the broadcast transmission of digital terrestrial television and DVB-
C is that for the broadcast transmission of digital TV over cable. However, some differentiated features like EPG (Electric 
Programme Guide), VOD (Video on Demand) and so on, are not included in this specification. So, they cannot be workable at 
this moment.

3.  Although this TV set meets the latest DVB-T and DVB-C standards, as of [August, 2008], the compatibility with future DVB-T 
digital terrestrial and DVB-C digital cable broadcasts cannot be guaranteed.

4.  Depending on the countries/areas where this TV set is used some cable-TV providers may charge an additional fee for such a 
service and you may be required to agree to terms and conditions of their business.

5.  Some Digital TV functions might be unavailable in some countries or regions and DVB-C might not work correctly with some 
cable service providers.

6.  For more information, please contact your local Samsung customer care centre.

Precautions When Displaying a Still Image 
A still image may cause permanent damage to the TV screen

Do not display a still image and partially still on the LCD panel for more than 2 hours as it can cause screen image retention. 
This image retention is also known as “screen burn”. To avoid such image retention, reduce the degree of brightness and 
contrast of the screen when displaying a still image.

Watching the LCD TV in 4:3 format for a long period of time may leave traces of borders displayed on the 
left, right and centre of the screen caused by the difference of light emission on the screen. Playing a DVD or 
a game console may cause a similar effect to the screen. Damages caused by the above effect are not 
covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. To 
prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images.

© 2009 Samsung Electronics Co., Ltd. All rights reserved.

❑

❑

●

●

●

Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance.
Product design and specifications may be changed without notice.
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English - 1

License

TruSurround HD, SRS and  symbol are trademarks of SRS Labs, Inc. TruSurround HD technology is 
incorporated under license from SRS Labs, Inc.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 
Dolby Laboratories.
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English - 2

GENERAL INFORMATION

Viewing the Control Panel
The product colour and shape may vary depending on the model.
You can use a button by pressing the side panel buttons.

1 SOURCE E: Toggles between all the available input sources. In the on-screen menu, use this button as you would use the 
ENTERE button on the remote control.

2 MENU: Press to see an on-screen menu of your TV’s features.
3 Y: Press to increase or decrease the volume. 

In the on-screen menu, use the Y buttons as you would use the ◄ and ► buttons on the remote control.
4 Z: Press to change channels. In the on-screen menu, use the Z buttons as you would use the ▼ and ▲ buttons 

on the remote control.
5 P (POWER): Press to turn the TV on and off.
6 SPEAKERS
7 REMOTE CONTROL SENSOR: Aim the remote control towards this spot on the TV.
8 POWER INDICATOR: Blinks and turns off when the power is on and lights up in stand-by mode.

Accessories

(M4 X L16)

Remote Control & 
Batteries (AAA x 2) Stand Stand Screw X 4 Cleaning Cloth Cover-Bottom Power Cord

Owner’s Instructions ● Warranty card● Safety Guide●

Please make sure the following items are included with your LCD TV. If any items are missing, contact your dealer.
Warranty card / Safety Guide (Not available in all locations)
The items colour and shape may vary depending on the model.

¦
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Viewing the Connection Panel

The product colour and shape may vary depending on the model.
Whenever you connect an external device to your TV, make sure that power on the unit is turned off. 
When connecting an external device, match the colour of the connection terminal to the cable.

1 DIGITAL AUDIO OUT (OPTICAL)
Connects to a Digital Audio component such as a Home theatre receiver.
When the HDMI IN jacks are connected, the DIGITAL AUDIO OUT (OPTICAL) jack on the TV outputs 2 channel audio 
only. If you want to hear 5.1 channel audio, connect the Optical jack on the DVD / Blu-ray player or Cable / Satellite Box 
directly to an Amplifier or Home Theatre, not the TV.

2 PC
Connect to the video output jack on your PC.

3 ANT IN
Connects to an antenna or cable TV system.

4 PC / DVI AUDIO IN
Connect to the audio output jack on your PC.
DVI audio outputs for external devices.

5 AUDIO OUT [R-AUDIO-L]
Connect RCA audio cables to AUDIO OUT [R-AUDIO-L] on the rear of your set and the other ends to corresponding 
audio in connectors on the Amplifier or DVD Home Theatre.

6 KENSINGTON LOCK (depending on the model)
The Kensington Lock (optional) is a device used to physically fix the system when used in a public place. If you want to 
use a locking device, contact the dealer where you purchased the TV.
The location of the Kensington Lock may be different depending on its model. 

7 HDMI IN 1(DVI), 2, 3
Connects to the HDMI jack of a device with an HDMI output. 
No sound connection is needed for an HDMI to HDMI connection.
Use the HDMI IN 1(DVI) jack for DVI connection to an external device. Use a DVI to HDMI cable or DVI-HDMI adapter 
(DVI to HDMI) for video connection and the PC / DVI AUDIO IN jacks for audio.
You can also use the ports to connect to a PC.
What is HDMI?
‘High Definition Multimedia interface’ allows the transmission of high definition digital video data and multiple channels of 
digital audio.
The HDMI / DVI terminal supports DVI connection to an extended device with the appropriate cable (not supplied). 
The difference between HDMI and DVI is that the HDMI device is smaller in size, has the HDCP (High Bandwidth Digital 
Copy Protection) coding feature installed, and supports multi - channel digital audio.
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The TV may not output sound and pictures may be displayed with abnormal colour when DVD / Blu-ray player / Cable Boxes 
/ Satellite receivers supporting HDMI versions older than 1.3 are connected. When connecting an older HDMI cable and 
there is no sound, connect the HDMI cable to the HDMI IN 1(DVI) jack and the audio cables to the PC / DVI AUDIO IN jacks 
on the back of the TV. If this happens, contact the company that provided the DVD / Blu-ray player / Cable Box / Satellite 
receiver to confirm the HDMI version, then request a firmware update. HDMI cables that are not 1.3 may cause annoying 
flicker or no screen display.

8 COMPONENT IN 
Connect component video cables (optional) to component connector (PR, PB, Y) on the rear of your set and the other ends 
to corresponding component video out connectors on the DTV or DVD.
If you wish to connect both the Set-Top Box and DTV (or DVD), you should connect the Set-Top Box to the DTV (or DVD) 
and connect the DTV (or DVD) to component connector (PR, PB, Y) on your set.
The PR, PB and Y connectors on your component devices (DTV or DVD) are sometimes labelled Y, B-Y and R-Y or Y, Cb 
and Cr.
Connect RCA audio cables (optional) to [R-AUDIO-L] on the rear of your set and the other ends to corresponding audio 
out connectors on the DTV or DVD.

9 EXT (RGB)

Connector Input Output
Video Audio (L / R) RGB Video + Audio (L / R)

EXT O O O Only TV or DTV output is available.
Inputs or outputs for external devices, such as VCR, DVD, video game device or video disc players.

0 SERVICE
Connector for software upgrades.

! AV IN [VIDEO] / [R-AUDIO-L]
Connect RCA cable to an appropriate external A/V device such as VCR, DVD or Camcorder.
Connect RCA audio cables to [R-AUDIO-L] on your set and the other ends to corresponding audio out connectors on the 
A/V device.

@ COMMON INTERFACE Slot
When not inserting ‘CI CARD’ in some channels, ‘Scrambled Signal’ is displayed on the screen.
The pairing information containing a telephone number, CI CARD ID, Host ID and other information will be displayed in 
about 2~3 minutes. If an error message is displayed, please contact your service provider.
When the channel information configuration has finished, the message ‘Updating Completed’ is displayed, indicating that 
the channel list is now updated.
You must obtain a CI CARD from a local cable service provider. Remove the CI CARD by carefully pulling it out with your
hands since dropping the CI CARD may cause damage to it.
Insert the CI-Card in the direction marked on it.
The place of the COMMON INTERFACE Slot may be different depending on its model.
CAM is not supported in some countries and regions, check with your authorized dealer.
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Remote Control
You can use the remote control up to a distance of about 23 feet from the TV.
The performance of the remote control may be affected by bright light.
The product colour and shape may vary depending on the model.

1 POWER : Television Standby 
button.

2 NUMERIC BUTTONS : Press to 
change the channel.

3 FAV.CH : Used to display 
Favourites Channel Lists on the 
screen.

4 Y : Press to increase or 
decrease the volume.

5 SOURCE : Press to display and 
select the available video sources.

6 INFO : Press to display information 
on the TV screen.

7 TOOLS : Use to quickly select 
frequently used functions.

8 CH LIST : Displays the Channel List 
on screen.

9 COLOURS BUTTONS : Use these 
buttons in the Channel list menus 
etc.

! DUAL : Sound effect selection
@ Use these buttons in the Anynet+ 

modes. (∏: This remote can 
be used to control recording on 
Samsung recorders with the 
Anynet+ feature)

# TV : Selects the TV mode directly.
$ PRE-CH : Enables you to return 

to the previous channel you were 
watching.

% MUTEM: Press to temporarily cut 
off the sound.

^ P </P > : Press to change 
channels.

& MENU : Displays the main on-screen 
menu

* GUIDE : Electronic Programme Guide 
(EPG) display

( RETURN : Returns to the previous menu
)	 UP▲	/	DOWN▼	/	LEFT◄	/	RIGHT►	

/ ENTERE : Use to select on-screen 
menu items and change menu values.

a EXIT : Press to exit the menu.
b P.SIZE : Picture size selection
c SRS : SRS TS HD selection.
d SUBT. : Digital subtitle display
e AD : Audio Description selection.

Teletext Functions
5 0 : Teletext mode selection (LIST / 

FLOF)
6 5 : Teletext reveal
7 4 : Teletext size selection
8 8 : Teletext store
9 Fastext topic selection
0 / : Alternately select Teletext, 

Double, or Mix.
# : : Exit from the Teletext display
$ 1 : Teletext sub page
^ 2 : Teletext next page

3 : Teletext previous page
& 6 : Teletext index
( 9 : Teletext hold
a 7 : Teletext cancel

Installing Batteries in the Remote Control
1. Lift the cover at the back of the remote control upward as shown in the figure.
2. Install two AAA size batteries. 

Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside the 
compartment.

3. Replace the cover.
Remove the batteries and store them in a cool, dry place if you won’t be using the 
remote control for a long time. 

If the remote control doesn’t work, check the following:
Is the TV power on? 
Are the plus and minus ends of the batteries reversed?
Are the batteries drained?
Is there a power outage or is the power cord unplugged?
Is there a special fluorescent light or neon sign nearby?

¦
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OPERATION

Viewing the menus
Before using the TV, follow the steps below to learn how to navigate the menu in order to select 
and adjust different functions.
1. Press the MENU button.

The main menu is displayed on the screen. Its left side has icons: Picture, Sound, 
Channel , Setup, Input, Application, Support.

2. Press the ▲ or ▼ button to select one of the icons.
Press the ◄ or ► button to access the icon’s sub-menu.

3. Press the ▲ or ▼ button to move to items in the menu.
Press the ENTERE button to enter items in the menu.

4. Press the ▲/▼/◄/► button to change the selected items.
Press the RETURN button to return to the previous menu.

5. Press the EXIT button to exit from the menu.

Using the remote control buttons
Button Operations Button Operations

MENUm Display the main on-screen menu.
▲/▼/◄/►/ 
ENTERE

Move the cursor and select an item.
Select the currently selected item.
Confirm the setting.

RUTURNR Return to the previous menu.
EXITe Exit the on-screen menu.

Example: Setting the TV’s Brightness in the Picture Menu

Adjusting the Brightness to 80
1. Press the MENU button to display the menu. 

2. Press the ENTERE button to select Picture. 

3. Press the ▲ or ▼ button to select Brightness.

4. Press the ENTERE button. 

5. Press the ◄ or ► button until the brightness becomes 80.
6. Press the ENTERE button.

Press the EXIT button to exit from the menu.

¦

N



N

Mode	 	 	 :	Standard	 ►
Backlight   : 7 

Contrast   : 95

Brightness   : 45

Sharpness  : 50

Colour   : 50

Tint (G / R)  : G50 / R50

Picture

Mode	 	 	 :	Standard		 ►
Backlight   : 7 

Contrast   : 95

Brightness   : 45

Sharpness  : 50

Colour   : 50

Tint (G / R)  : G50 / R50

Picture

Backlight   : 7 
Contrast   : 95

Brightness	 	 :	45		 	 ►
Sharpness  : 50

Colour   : 50

Tint (G / R)  : G50 / R50

Advanced Settings

Picture Options

Picture Reset

Picture

U Move   L Adjust   E Enter   R Return

45Brightness

U Move   L Adjust   E Enter   R Return

80Brightness

Mode	 	 	 :	Standard		 ►
Backlight   : 7 

Contrast   : 95

Brightness   : 45

Sharpness  : 50

Colour   : 50

Tint (G / R)  : G50 / R50

Picture
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Placing Your Television in Standby Mode
Your set can be placed in standby mode in order to reduce the power consumption. The standby mode can be useful when you 
wish to interrupt viewing temporarily (during a meal, for example).
1. Press the POWERP button on the remote control.

The screen is turned off and a standby indicator appears on your set.
2. To switch your set back on, simply press the POWERP button again.

Do not leave your set in standby mode for long periods of time (when you are away on holiday, for example). It is best to 
unplug the set from the mains and aerial.

Plug & Play Feature
When the TV is initially powered on, basic settings proceed automatically and subsequently.
1. Press the POWER button on the remote control. The message You can set the menu 

language. is displayed.
2. Select the appropriate language by pressing the ▲ or ▼ button. Press the ENTERE 

button to confirm your choice.
3. Press the ◄ or ► button to select Store Demo or Home Use, then the ENTERE button. 

We recommend setting the TV to Home Use mode for the best picture in your home environment. 
Store Demo mode is only intended for use in retail environments. 
If the unit is accidentally set to Store Demo mode and you want to return to Home Use (Standard): Press the Volume 
button on the TV. When the volume OSD is displayed, press and hold the MENU button on the TV for 5 seconds.

4. Press the ENTERE button. Select the appropriate country by pressing the ▲ or ▼ button. Press the ENTERE button to 
confirm your choice.

5. Press the ▲ or ▼ button to select Air or Cable, then press the ENTERE button.
Air: Air antenna signal.
Cable: Cable antenna signal.

6. Press the ▲ or ▼ button to select the channel source to memorize. Press the ENTERE button to select Start.
Digital & Analogue: Digital and Analogue channels. 
Digital: Digital channels. 
Analogue: Analogue channels.
When setting the antenna source to Cable, a step appears allowing you to set a value for the digital channel search. For 
more information, refer to Channel	→	Auto	Store.
The channel search will start and end automatically.
Some channel may not be transmitted to this television. It depends on Broadcasting signal gain or specification.
Press the ENTERE button at any time to interrupt the memorization process.
After all the available channels are stored, the message Set the Clock Mode. is displayed.

�. Press the ENTERE button. Press the ▲ or ▼ button to select Auto, then Press the ENTERE button.
If you select Manual, Set current date and time is displayed.
If you have received a digital signal, the time will be set automatically. If not, select Manual to set the clock. (refer to page 
19)

8. The connection method to provide the best quality HD is offered. After confirming the method, press the ENTERE button.
9. The message Enjoy your TV! is displayed. When you have finished, press the ENTERE button.

If you want to reset this feature...
1. Press the MENU button to display the menu. Press the ▲ or ▼ button to select Setup, then press the ENTERE button.
2. Press the ENTERE button again to select Plug & Play. 
3. Enter your 4 digit PIN number. The default PIN number of a new TV set is ‘0-0-0-0’.

If you want to change PIN number, use the Change PIN function. (refer to page 21)
The Plug & Play feature is only available in the TV mode. 

¦

N

N

¦
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Plug & Play
You can set the menu language.

Menu Language : English   ►

E Enter
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Viewing the Display
The display identifies the current channel and the status of certain audio-video settings.

Press the INFO button to viewing the information.

Press the INFO button on the remote control. The TV will display the channel, the type of 
sound, and the status of certain picture and sound settings.

▲, ▼: You can view other channel’s information. If you want to move to the currently 
selected channel, press ENTERE button.
◄, ►: You can view the desired program’s information at the current channel.

Press the INFO button once more or wait approximately 10 seconds and the display 
disappears automatically.

 CHANNEL CONTROL

Configuring	the	Channel	Menu

Country
The PIN number input screen appears. Enter your 4 digit PIN number. 

Analogue Channel
You can change the country for analogue channels.
Digital Channel
You can change the country for digital channels.

Auto Store
You can scan for the frequency ranges available to you (and availability depends on your country). Automatically allocated 
programme numbers may not correspond to actual or desired programme numbers.

If a channel is locked using the Child Lock function, the PIN input window appears.
Air / Cable
Antenna source to memorize

Digital & Analogue: Digital and Analogue channels. 
Digital: Digital channels. 
Analogue: Analogue channels.

When selecting Cable	→	‘Digital	&	Analogue’	or	‘Cable	→	Digital’
Provide a value to scan for cable channels.

Search	Mode	→	Full	/	Network	/	Quick
Quick

Network ID: Displays the network identification code.
Frequency: Displays the frequency for the channel. (Differs in each country)
Modulation: Displays available modulation values.
Symbol Rate: Displays available symbol rates.

–
–
–
–

Scans for all channels with active broadcast stations and stores them in the TV’s memory.
If you want to stop Auto Store, press the ENTERE button.
The Stop Auto Store? message will be displayed.
Select Yes by pressing the ◄ or ► button, then press the ENTERE button.

¦

O

●

●

N

¦

❑

N





❑

N



●
●
●

●
N

N
N

Country	 		 	 	 ►
Auto Store

Manual Store

Cable Search Option

Now & Next Guide

Full Guide

Default Guide  : Full Guide

Channel

DTV Air

15
abc1

18:00 ~ 6:00 

18:11 Thu 6 Jan 

 Life On Venus Avenue
Unclassified
No Detaild Information  '  INFO
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Manual Store
Scans for a channel manually and stores it in the TV’s memory.
If a channel is locked using the Child Lock function, the PIN input window appears.

Digital Channel
Manual store for digital channels.

Digital Channel is only available in DTV mode.
Channel: Set the Channel number using the ▲, ▼ or number (0~9) buttons.
Frequency: Set the frequency using the number buttons.
Bandwidth: Set the bandwidth using the ▲, ▼ or number (0~9) buttons.
When it has finished, channels are updated in the channel list.

Analogue Channel
Manual store for analogue channel.

Programme (Programme number to be assigned to a channel): Sets the programme number using the ▲, ▼ or number (0~9) 
buttons.
Colour	System	→	Auto	/	PAL	/	SECAM	/	NTSC4.43: Sets the colour system value using the ▲ or ▼ button.
Sound	System	→	BG	/	DK	/	I	/	L: Sets the sound system value using the ▲ or ▼ button.
Channel (When you know the number of the channel to be stored): Press the ▲ or ▼ button to select C (Air channel) or S 
(Cable channel). Press the ► button, then press the ▲, ▼ or number (0~9) buttons to select the required number.

You can also select the channel number directly by pressing the number (0~9) buttons.
If there is abnormal sound or no sound, reselect the sound standard required.

Search (When you do not know the channel numbers): Press the ▲ or ▼ button to start the search. The tuner scans the 
frequency range until the first channel or the channel that you selected is received on the screen.
Store (When you store the channel and associated programme number): Set to OK by pressing the ENTERE button.
Channel mode

P (Programme mode): When completing tuning, the broadcasting stations in your area have been assigned to position 
numbers from P00 to P99. You can select a channel by entering the position number in this mode.
C (Air channel mode): You can select a channel by entering the assigned number to each air broadcasting station in this 
mode.
S (Cable channel mode): You can select a channel by entering the assigned number for each cable channel in this mode.

Cable Search Option (depending on the country)
Sets additional search options such as the frequency and symbol rate for cable network searches.

Frequency (Start ~ Stop): Displays the frequency for the channel.
Modulation: Displays available modulation values.
Symbol Rate: Displays available symbol rates.

Now & Next Guide / Full Guide
The EPG (Electronic Programme Guide) information is provided by the broadcasters. Programme entries may appear blank or out 
of date as a result of the information broadcast on a given channel. The display will dynamically update as soon as new information 
becomes available.

For detailed procedures on using Now & Next Guide and Full Guide, refer to the descriptions on page 10.
You can also display the guide menu simply by pressing the GUIDE button. (To configure the Default Guide, refer to the 
descriptions.)

Now & Next Guide
For the six channels indicated in the left-hand column, displays the Current programme and the Next programme information.
Full Guide
Displays the programme information as time ordered One hour segments. Two hours of programme information is displayed which 
may be scrolled forwards or backwards in time.
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Default	Guide	→	Now	&	Next	Guide	/	Full	Guide
You can decide whether to display either the Now & Next Guide or the Full Guide when the GUIDE button on the remote control 
is pressed. 

Channel List
For detailed procedures on using the Channel List, refer to the ‘Managing Channels’ instructions.

You can select these options by simply pressing the CH LIST button on the remote control.

Channel Mode
When press the P >/< button, Channels will be switched within the selected channel list.
Added Ch.
Channels will be switched within the memorized channel list.
Favourite Ch.
Channels will be switched within the favourite channel list.

Fine Tune
If the reception is clear, you do not have to fine tune the channel, as this is done automatically during the search and store 
operation. If the signal is weak or distorted, you may have to fine tune the channel manually.

Fine tuned channels that have been saved are marked with an asterisk ‘*’ on the right-hand side of the channel number in the 
channel banner.
To reset the fine-tuning, select Reset by pressing the ▲ or ▼ button and then press the ENTERE button. 
Only Analogue TV channels can be fine tuned.

Using the Now & Next Guide / Full Guide

To... Then...
Watch a programme in the EPG list Select a programme by pressing the ▲, ▼, ◄, ► button.
Exit the guide Press the blue button
If the next programme is selected, it is scheduled with the clock icon displayed. If the ENTERE button is pressed again, press the 
◄, ► button to select Cancel Schedules, the scheduling is cancelled with the clock icon gone. 
View programme information Select a programme of your choice by pressing the ▲, ▼, ◄, ► button. 

Then press the INFO button when the programme of your choice is 
highlighted.
The programme title is on the upper part of the screen centre. 

Please click on INFO button for detailed information. Channel Number, Running Time, Status Bar, Parental Level, Video Quality 
Information (HD / SD), Sound Modes, Subtitle or Teletext, languages of Subtitle or Teletext and brief summary of the highlighted 
programme are included on the detailed information. “...” will be appeared if the summary is long.
Toggle between the Now & Next Guide and Full 
Guide

Press the red button repeatedly.

In Full Guide 
Scrolls backwards quickly (24 hours). 
Scrolls forwards quickly (24 hours).

Press the green button repeatedly.
Press the yellow button repeatedly.

❑

❑

O

❑





❑

N

N
N

Now & Next Guide
DTV Cable 900 f tn                               2:10  Tue 1 Jun
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Now Next

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

1       f tn
2       ITV Play
3       Kerrang!
4       Kiss
5       oneword
6       Smash Hits!▼

Street Hypn..

Kisstory
No Information

No Information

No Information

 Watch          INFO  Information          ■	Full Guide          ■ Exit

Full Guide
DTV Cable 900 f tn                               2:10  Tue 1 Jun
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Today 2:00 - 3:00 3:00 - 4:00

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

1       f tn
2       ITV Play
3       Kerrang!
4       Kiss
5       oneword
6       Smash Hits!▼

No Information

Freshmen O..

 Watch          INFO  Information          ■	Now/Next          ■ +24 Hours          ■ Exit
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Managing Channels 
Using this menu, you can Add / Delete or set Favourite channels and use the programme guide 
for digital broadcasts.
All Channels
Shows all currently available channels.
Added Channels
Shows all added channels.
Favourites
Shows all favourite channels.

To select the Favourites channels you have set up, press the FAV.CH button on the remote control.
Programmed
Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels or Favourites screen by pressing the ▲ / ▼ buttons, and pressing 
the ENTERE button. Then you can watch the selected channel.
Using the Colour buttons with the Channel List

Red (Channel Type): Toggle between your TV, Radio, Data / Other and All.
Green (Zoom): Enlarges or shrinks a channel number.
Yellow (Select): Selects multiple channel lists. You can perform the add / delete, add to Favourites / delete from 
Favourites, or lock / unlock function for multiple channels at the same time. Select the required channels and press the 
yellow button to set all the selected channels at the same time. The c mark appears to the left of the selected channels.
TOOLS (Tools): Displays the Delete (or Add), Add to Favourite (or Delete from Favourite), Lock (or Unlock), Timer 
Viewing, Edit Channel Name, Sort, Edit Channel Number, Select All (or Deselect All), Auto Store menu. (The 
Options menus may differ depending on the situation.)

Channel Status Display Icons
A : An analogue channel.
c: A channel selected by pressing the yellow button.
* : A channel set as a Favourite.
( : A programme currently being broadcast.
\  : A locked channel.
) : A reserved programme

Channel List Option Menu (in All Channels / Added Channels / Favourites)
Press the TOOLS button to use the option menu.
Option menu items may differ depending on the channel status.

Add / Delete
You can delete or add a channel to display the channels you want.

All deleted channels will be shown on All Channels menu.
A gray-coloured channel indicates the channel has been deleted. 
The Add menu only appears for deleted channels.
You can also delete a channel from the Added Channels or Favourite menu in the same 
manner.

Add to Favourite / Delete from Favourite
You can set channels you watch frequently as favourites.

Press the TOOLS button to display the Tools menu. You can also set the add to (or delete from) Favourite by selecting Tools 
→	Add	to	Favourite	(or Delete from Favourite).
The ‘*’ symbol will be displayed and the channel will be set as a favourite.
All favourite channels will be shown on Favourite menu.
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824                  UKTV Gold
825                  UKTV style

A  1             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --
A  7                  C --

Added Channels
All        ■ Channel Type           ■ Zoom           ■ Select          T Tools

824                  UKTV Gold
825                  UKTV style

A  1             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --
A  7                  C --

Added Channels

All        ■ Channel Type           ■ Zoom           ■ Select          T Tools

Delete
Add to Favourite
Lock
Timer Viewing
Edit Channel Name
Sort

▼
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Lock / Unlock
You can lock a channel so that the channel cannot be selected and viewed. This function is available only when the Child Lock is 
set to On. (see page 21)

The PIN number input screen appears. Enter your 4 digit PIN number. 
The default PIN number of a new TV set is ‘0-0-0-0’. You can change the PIN, by selecting Change PIN from the menu.
The ‘\’ symbol will be displayed and the channel will be locked.

Timer Viewing
If you reserve a programme you want to watch, the channel is automatically switched to the reserved channel in the Channel List; 
even when you are watching another channel. To reserve a programme, set the current time first. (See page 19)

Only memorized channels can be reserved.
You can set the channel, day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Reserving a programme will be shown in the Programmed menu.
Digital Programme Guide and Viewing Reservation
When a digital channel is selected, and you press the ► button, the Programme Guide for the channel appears. You can 
reserve a programme according to the procedures described above.

Edit Channel Name (analogue channels only)
Channels can labelled so that their call letters appear whenever the channel is selected.

The names of digital broadcasting channels are automatically assigned and cannot be labelled.
Edit Channel Number (digital channels only)
You can also edit the channel number by pressing the number buttons on the remote control.
Sort (analogue channels only)
This operation allows you to change the programme numbers of the stored channels. This operation may be necessary after using 
the auto store.
Select All / Deselect All

Select All: You can select all the channels in the channel list.
Deselect All: You can deselect all the selected channels.
You can only select Deselect All when there is a selected channel.

Auto Store
For further details on setting up options, refer to page 8.
If a channel is locked using the Child Lock function, the PIN input window appears.

Channel List Option Menu (in Programmed )
You can view, modify or delete a reservation.

Press the TOOLS button to use the option menu.
Change Info
Select to change a viewing reservation.
Cancel Schedules
Select to cancel a viewing reservation.
Information
Select to view a viewing reservation. (You can also change the reservation information.)
Select All
Select all reserved programmes.
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1 / 1 / 2009

13:59 5 TV1  Quincy, M.E

18:59 2 TV3  The Equalizer

20:59 2 TV3  McMillan & Wife

Programmed

       All         ■ Zoom     ■ Select    T Tools    E Information 

Change Info
Cancel Schedules
Information
Select All
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PICTURE CONTROL

Configuring	the	Picture	Menu

Mode
You can select the type of picture which best corresponds to your viewing requirements.

Press the TOOLS button to display the Tools menu. You can also set the picture mode by 
selecting Tools	→	Picture	Mode.

Dynamic
Selects the picture for high-definition in a bright room.
Standard
Selects the picture for the optimum display in a normal environment.
Movie
Selects the picture for viewing movies in a dark room. 

Backlight / Contrast / Brightness / Sharpness / Colour / Tint (G/R)
Your television has several setting options that allow you to control the picture quality.

Backlight: Adjusts the brightness of LCD back light.
Contrast: Adjusts the contrast level of the picture.
Brightness: Adjusts the brightness level of the picture
Sharpness: Adjusts the edge definition of the picture.
Colour: Adjusts colour saturation of the picture.
Tint (G/R): Adjusts the colour tint of the picture.
Select a picture mode to be adjusted first. The adjusted values are saved for each picture mode.
When you make changes to Backlight, Contrast, Brightness, Sharpness, Colour or Tint (G/R), the OSD will be adjusted 
accordingly.
In analogue TV, Ext., AV modes of the PAL system, you cannot use the Tint (G/R) Function.
In PC mode, you can only make changes to Backlight, Contrast and Brightness.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
The energy consumed during use can be significantly reduced if the brightness level of the picture is reduced, which will 
reduce the overall running cost.

Advanced Settings
Samsung’s new TVs allow you to make even more precise picture settings than previous models. See below to adjust detailed 
picture settings.

Advanced Settings is available in Standard or Movie mode.
In PC mode, you can only make changes to Gamma and White Balance from among the Advanced Settings items.

Black	Tone	→	Off	/	Dark	/	Darker	/	Darkest
You can select the black level on the screen to adjust the screen depth.
Dynamic	Contrast	→	Off	/	Low	/	Medium	/	High
You can adjust the screen contrast so that the optimal contrast is provided.
Gamma
You can adjust the Primary Colour (Red, Green, Blue) Intensity.
Colour Space
Colour Space is a colour matrix composed of red, green and blue colours. Select your favourite Colour Space to experience the 
most natural colour.

Native: Native Colour Space offers deep and rich colour tone.
Auto: Auto Colour Space automatically adjusts to the most natural colour tone based on programme sources.
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Mode	 	 :	Standard		 	 ►
Backlight   : 7 

Contrast   : 95

Brightness   : 45

Sharpness  : 50

Colour   : 50

Tint (G / R)  : G50 / R50

Picture

Colour : 50
Tint (G / R) : G50 / R50

Advanced	Settings	 	 ►
Picture Options

Picture Reset

Picture
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White Balance
You can adjust the colour temperature for more natural picture colours.

R-Offset / G-Offset / B-Offset / R-Gain / G-Gain / B-Gain: You can adjust the Colour ‘temperature’ in the light areas by 
changing the values of R, G, B. Recommended for advanced users only.
Reset: The previously adjusted white balance will be reset to the factory defaults.

Flesh Tone
You can emphasize the pink ‘flesh tone’ in the picture.

Changing the adjustment value will refresh the adjusted screen.
Edge	Enhancement	→	Off	/	On
You can emphasize object boundaries in the picture.

Picture Options
In PC mode, you can only make changes to the Colour Tone and Size from among the items in Picture Options.

Colour	Tone	→	Cool	/	Normal	/	Warm1	/	Warm2
You can select the most comfortable colour tone to your eyes.

Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Warm1 or Warm2 is only activated when the picture mode is Movie.

Size
You can select the picture size which best corresponds to your viewing requirements. 

Press the TOOLS button to display the Tools menu. You can also set the size by selecting Tools	→	Picture	Size.
You can select these options by simply pressing the P.SIZE button on the remote control.
Auto Wide: Automatically adjusts the picture size to the 16:9 aspect ratio.
16:9: Adjusts the picture size to 16:9 appropriate for DVDs or wide broadcasting.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnifies the 16:9 wide picture (in the vertical direction) to fit the screen size.
4:3: This is the default setting for a video movie or normal broadcasting.
Screen Fit: Use the function to see the full image without any cut-off when HDMI (720p / 1080i / 1080p) or Component (1080i 
/ 1080p) signals are input.
Depending on the input source, the picture size options may vary.
The items available may differ depending on the selected mode.
In PC Mode, only 16:9 and 4:3 mode can be adjusted.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Temporary image retention may occur when viewing a static image on the set for more than two hours.
Wide Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the 
picture up / down. Then press the ENTERE button.
Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the picture 
up and down. Then press the ENTERE button. Press the ► button to Select Size, then press the ENTERE button. Press 
the ▲ or ▼ button to magnify or reduce the picture size in the vertical direction. Then press the ENTERE button.
After selecting Screen Fit in HDMI (1080i / 1080p) or Component (1080i / 1080p) mode: Select Position by pressing the ◄ or ► 
button. Use the ▲, ▼, ◄ or ► button to move the picture.
Reset: Press the ◄ or ► button to select Reset, then press the ENTERE button. You can initialize the setting.
If you use the Screen Fit function with HDMI 720p input, 1 line will be cut at the top, bottom, left and right as in the Overscan 
function.

Screen	Mode	→	16:9	/	Wide	Zoom	/	Zoom	/	4:3
When setting the picture size to Auto Wide in a 16:9 wide TV, you can determine the picture size you want to see the 4:3 WSS 
(Wide Screen Service) image or nothing. Each individual European country requires different picture size so this function is 
intended for users to select it.

16:9: Sets the picture to 16:9 wide mode.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnify the size of the picture vertically on screen.
4:3: Sets the picture to 4:3 normal mode.
This function is available in Auto Wide mode.
This function is not available in PC, Component or HDMI mode.
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Digital	NR	→	Off	/	Low	/	Medium	/	High	/	Auto
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction feature to help reduce any static 
and ghosting that may appear on the screen.

When the signal is weak, select one of the other options until the best picture is displayed.
HDMI	Black	Level	→	Normal	/	Low
You can directly select the black level on the screen to adjust the screen depth.

This function is active only when the external input connects to HDMI (RGB signals).
Film	Mode	→	Off	/	Auto
The TV can be set to automatically sense and process film signals from all sources and adjust the picture for optimum quality.

Film Mode is supported in TV, AV, COMPONENT(480i / 1080i) and HDMI(480i / 1080i).

Picture	Reset	→	Reset	Picture	Mode	/	Cancel
Resets all picture settings to the default values.

Select a picture mode to be reset. The reset is performed for each picture mode.
Reset Picture Mode: Current picture values return to default settings.
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N
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Using Your TV as a Computer (PC) Display

Setting Up Your PC Software (Based on Windows XP)
The Windows display-settings for a typical computer are shown below. The actual screens on your PC will probably be different, 
depending upon your particular version of Windows and your particular video card. However, even if your actual screens look 
different, the same basic set-up information will apply in almost all cases. (If not, contact your computer manufacturer or Samsung 
Dealer.)
1. First, click on ‘Control Panel’ on the Windows start menu.
2. When the control panel window appears, click on ‘Appearance and Themes’ and a display dialog-box will appear.
3. When the control panel window appears, click on ‘Display’ and a display dialogbox will appear.
4. Navigate to the ‘Settings’ tab on the display dialog-box.

The correct size setting (resolution): Optimum-1920 X 1080 pixels
If a vertical-frequency option exists on your display settings dialog box, the correct value is ‘60’ or ‘60 Hz’. Otherwise, just click 
‘OK’ and exit the dialog box.

¦
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Display Modes
Both screen position and size will vary depending on the type of PC monitor and its resolution. The resolutions in the table are 
recommended.

D-Sub and HDMI/DVI Input

Mode Resolution Horizontal Frequency 
(KHz)

Vertical Frequency 
(Hz)

Pixel Clock Frequency 
(MHz)

Sync Polarity 
(H / V)

IBM 640 x 350 31.469 70.086 25.175 +/-
720 x 400 31.469 70.087 28.322 -/+

MAC 640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-
1152 x 870 68.681 75.062 100.000 -/-

VESA CVT 720 x 576 35.910 59.950 32.750 -/+
1152 x 864 53.783 59.959 81.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 960 75.231 74.857 130.000 -/+
1280 x 720 56.456 74.777 95.750 -/+

VESA DMT 640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.861 72.809 31.500 -/-
640 x 480 37.500 75.000 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 48.077 72.188 50.000 +/+
800 x 600 46.875 75.000 49.500 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1152 x 864 67.500 75.000 108.000 +/+

1280 x 1024 63.981 60.020 108.000 +/+
1280 x 1024 79.976 75.025 135.000 +/+
1280 x 800 49.702 59.810 83.500 -/+
1280 x 800 62.795 74.934 106.500 -/+
1280 x 960 60.000 60.000 108.000 +/+
1360 x 768 47.712 60.015 85.500 +/+
1440 x 900 55.935 59.887 106.500 -/+
1440 x 900 70.635 74.984 136.750 -/+

1680 x 1050 65.290 59.954 146.250 -/+
VESA GTF 1280 x 720 52.500 70.000 89.040 -/+

1280 x 1024 74.620 70.000 128.943 -/-
VESA DMT / 

DTV CEA 1920 x 1080p 67.500 60.000 148.500 +/+

When using an HDMI / DVI cable connection, you must use the HDMI IN 1(DVI) jack.
The interlace mode is not supported.
The set might operate abnormally if a non-standard video format is selected.
Separate and Composite modes are supported. SOG is not supported.
Too long or low quality VGA cable can cause picture noise at high resolution modes (1920x1080 or 1600x1200).

Setting up the TV with your PC
Preset: Press the SOURCE button to select PC mode.

Auto Adjustment
Auto Adjustment allows the PC screen of set to self-adjust to the incoming PC video signal. 
The values of fine, coarse and position are adjusted automatically.

This function does not work in DVI-HDMI mode.
Press the TOOLS button to display the Tools menu. You can also set the Auto Adjustment 
by selecting Tools	→	Auto	Adjustment.

Screen
Coarse / Fine
The purpose of picture quality adjustment is to remove or reduce picture noise. If the noise is not removed by Fine-tuning alone, 
then adjust the frequency as best as possible (Coarse) and Fine-tune again. After the noise has been reduced, readjust the picture 
so that it is aligned on the centre of screen.
PC Position
Adjust the PC’s screen positioning if it does not fit the TV screen. Press the ▲ or ▼ button to adjusting the Vertical-Position. Press 
the ◄ or ► button to adjust the Horizontal-Position.
Image Reset
You can replace all image settings with the factory default values.
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Brightness :  : 45 
Sharpness  : 50

Auto	Adjustment	 	 	 ►
Screen 

Advanced Settings 

Picture Options  

Picture Reset 

Picture
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SOUND CONTROL

Configuring	the	Sound	Menu

Mode	→	Standard	/	Music	/	Movie	/	Clear	Voice	/	Custom
You can select a sound mode to suit your personal preferences.

Press the TOOLS button to display the Tools menu. You can also configure the sound 
mode by selecting Tools → Sound Mode.

Standard
Selects the normal sound mode.
Music
Emphasizes music over voices.
Movie
Provides the best sound for movies.
Clear Voice
Emphasizes voice over other sounds.
Custom
Recalls your customized sound settings.

Equalizer
The sound settings can be adjusted to suit your personal preferences.
Mode
You can select a sound mode to suit your personal preferences.
Balance
Controls the balance between the right and left speakers.
100Hz / 300Hz / 1KHz / 3KHz / 10KHz (Bandwidth Adjustment)
To adjust the level of different bandwidth frequencies
Reset
Resets the equalizer settings to the default values.

SRS	TruSurround	HD	→	Off	/	On
SRS TruSurround HD is a patented SRS technology that solves the problem of playing 5.1 multichannel content over two 
speakers. TruSurround delivers a compelling, virtual surround sound experience through any two-speaker playback system, 
including internal television speakers. It is fully compatible with all multichannel formats.

Press the SRS button on the remote control to select Off or On.

Audio Language (digital channels only)
You can change the default value for audio languages. Displays the language information for the incoming stream.

You can only select the language among the actual languages being broadcast.
While viewing a digital channel, this function can be selected.

Audio	Format	→	MPEG	/	Dolby	Digital (digital channels only)
When sound is emitted from both the main speaker and the audio receiver, a sound echo may occur due to the decoding speed 
difference between the main speaker and the audio receiver. In this case, use the TV Speaker function.

The Audio Format appears according to the broadcasting signal.
While viewing a digital channel, this function can be selected.

Audio Description (digital channels only)
This is an auxiliary audio function that provides an additional audio track for visually challenged persons. This function handles the 
Audio Stream for the AD (Audio Description), when it is sent along with the Main audio from the broadcaster. Users can turn the 
Audio Description On or Off and control the volume.

Press the AD button on the remote control to select Off or On.
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Mode	 	 	 :	Custom	 ►
Equalizer

SRS TruSurround HD : Off

Audio Language  : - - -

Audio Format  : - - -

Audio Description

Auto Volume  : Off

Sound
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Audio	Description	→	Off	/	On
Turn the audio description function on or off.
Volume
 You can adjust the audio description volume.

Volume is active when Audio Description is set to On.

Auto	Volume	→	Off	/	On
Each broadcasting station has its own signal conditions, and so it is not easy to adjust the volume every time the channel is 
changed. This feature lets you automatically adjust the volume of the desired channel by lowering the sound output when the 
modulation signal is high or by raising the sound output when the modulation signal is low.

Speaker	Select	→	External	Speaker	/	TV	Speaker
If you want to hear the sound through separate speakers, cancel the internal amplifier.

The volume and MUTE buttons do not operate when the Speaker Select is set to External Speaker.
If you select External Speaker in the Speaker Select menu, the sound settings will be limited.

Sound	Reset	→	Reset	All	/	Reset	Sound	Mode	/	Cancel
You can restore the Sound settings to the factory defaults.

Selecting the Sound Mode
You can set the sound mode by pressing the DUAL button. When you press it, the current sound mode is displayed on the screen.

Audio Type Dual 1 / 2 Default

A2 Stereo
Mono MONO

Automatic change
Stereo STEREO	↔	MONO
Dual DUAL	1	↔	DUAL	2 DUAL 1

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO	↔	STEREO

Dual MONO	↔	DUAL	1	
DUAL 2 DUAL 1

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.
This function is only activated in stereo sound signal. It is deactivated in mono sound signal.
This function is only available in TV mode.
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SETUP

Configuring	the	Setup	Menu

Menu Language
You can set the menu language.

Time
Clock
Setting the clock is necessary in order to use the various timer features of the TV.

The current time will appear every time you press the INFO button.
If you disconnect the power cord, you have to set the clock again.
Clock Mode
You can set up the current time manually or automatically.

Auto: Set the current time automatically using the time from the digital broadcast.
Manual: Set the current time to a manually specified time.
Depending on the broadcast station and signal, the auto time may not be set correctly. If this occurs, set the time 
manually. 
The Antenna or cable must be connected in order to set the time automatically.

Clock Set
You can set the current time manually.

Set up this item when you have set Clock Mode to Manual.
You can set the day, month, year, hour and minute directly by pressing the number buttons on the remote control.

Sleep	Timer	→	Off	/	30	min	/	60	min	/	90	min	/	120	min	/	150	min	/	180	min
The sleep timer automatically shuts off the TV after a preset time (30, 60, 90, 120, 150 and 180 minutes).

The TV automatically switches to standby mode when the timer reaches 0.
To cancel the Sleep Timer function, select Off.
Press the TOOLS button to display the Tools menu. You can also set the sleep timer by selecting Tools	→	Sleep	Timer.

Timer 1 / Timer 2 / Timer 3
Three different on / off timer settings can be made. You must set the clock first.

On Time: Set the hour, minute, and activate / inactivate. (To activate the timer with the setting you’ve chosen, set to Activate.)
Off Time: Set the hour, minute, and activate / inactivate. (To activate the timer with the setting you’ve chosen, set to Activate.)
Volume: Select the desired turn on volume level.
Antenna: Select Air or Cable.
Channel: Select the desired channel.
Repeat: Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun or Manual.

When Manual is selected, press the ► button to select the desired day of the week. Press the ENTERE button over the 
desired day and the c mark will appear.

You can set the hour, minute and channel by pressing the number buttons on the remote control.
Auto Power Off
When you set the timer On, the television will eventually turn off, if no controls are operated for 3 hours after the TV was 
turned on by the timer. This function is only available in timer On mode and prevents overheating, which may occur if a TV is 
on for too long time.
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Plug & Play 

Menu	Language	 :	English	 ►
Time

Broadcast

Security

General

Setup
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Broadcast
Subtitle
You can activate and deactivate the subtitles. Use this menu to set the Subtitle Mode. Normal under the menu is the basic subtitle 
and Hard of hearing is the subtitle for a hearing-impaired person.

Subtitle	→	Off	/	On : Switches subtitles on or off.
Mode	→	Normal	/	Hard	of	hearing: Sets the subtitle mode.
Subtitle Language: Set the subtitle language.
If the programme you are watching does not support the Hard of hearing function, Normal automatically activates even 
though Hard of hearing mode is selected.
English is the default in cases where the selected language is unavailable in the broadcast.
You can select these options simply by pressing the SUBT. button on the remote control.

Digital	Text	→	Disable	/	Enable (UK only)
If the programme is broadcast with digital text, this feature is enabled.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)
An International standard for data encoding systems used in multimedia and hypermedia. This is at a higher level than the 
MPEG system which includes data-linking hypermedia such as still images, character service, animation, graphic and video 
files as well as multimedia data. MHEG is user runtime interaction technology and is being applied to various fields including 
VOD (Video-On-Demand), ITV (Interactive TV), EC (Electronic Commerce), tele-education, tele-conferencing, digital libraries 
and network games.

 Teletext Language
You can set the Teletext language by selecting the language type.

English is the default in cases where the selected language is unavailable in the broadcast.
Preference

Primary Audio Language / Secondary Audio Language / Primary Subtitle Language / Secondary Subtitle Language / 
Primary Teletext Language / Secondary Teletext Language 
Using this feature, users can select one of the languages. The language selected here is the default when the user selects a 
channel.
If you change the language setting, the Subtitle Language, Audio Language, and the Teletext Language of the Language 
menu are automatically changed to the selected language.
The Subtitle Language, Audio Language, and the Teletext Language of the Language menu show a list of languages 
supported by the current channel and the selection is highlighted. If you change this language setting, the new selection is 
only valid for the current channel. The changed setting does not change the setting of the Primary Subtitle Language, Primary 
Audio Language, or the Primary Teletext Language of the Preference menu.

Common Interface
CI Menu
This enables the user to select from the CAM-provided menu. Select the CI Menu based on the menu PC Card.
Application Info.
This contains information on CAM inserted in the CI slot and displays it. 

The Application Info inserting is about the ‘CI CARD’. You can install the CAM anytime whether the TV is ON or OFF.
1. Purchase the CI CAM module by visiting your nearest dealer or by phone.
2. Insert the ‘CI CARD’ into the CAM in the direction of the arrow until it fits.
3. Insert the CAM with the ‘CI CARD’ installed into the common interface slot. 
    (Insert the CAM in the direction of the arrow, right up to the end so that it is parallel with the slot.)
4. Check if you can see a picture on a scrambled signal channel.
CAM is not supported in some countries and regions, check with your authorized dealer.
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Security
Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number. The default PIN number of 
a new TV set is ‘0-0-0-0’. You can change the PIN by selecting Change PIN from the menu.
	Child	Lock	→	Off	/	On
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by muting out video 
and audio.

You can lock some channels in Channel List. (refer to page 12)
Child Lock is available only in TV mode.

Parental Lock
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by a 4-digit PIN 
(Personal Identification Number) code that is defined by the user.

The Parental Lock item differs depending on the country.
When the Parental Lock is set, the ‘\’ symbol is displayed.
Allow All: Press to unlock all TV ratings.
Block All: Press to lock all TV ratings.

Change PIN
You can change your personal ID number that is required to set up the TV.

If you forget the PIN code, press the remote control buttons in the following sequence, which resets the PIN to ‘0-0-0-0’: 
POWER(Off) → MUTE → 8 → 2 → 4 → POWER(On).

General
Game	Mode	→	Off	/	On
When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more realistic gaming experience by 
selecting the game menu.

To disconnect the game console and connect another external device, cancel game mode in the setup menu.
If you display the TV menu in Game Mode, the screen shakes slightly.
Game Mode is not available in regular TV and PC mode.
If Game Mode is On:

Picture mode is automatically changed to Standard and users cannot change the mode.
Sound mode is automatically changed to Custom and users cannot change the mode. Adjust the sound using the 
equalizer.

The Reset Sound function is activated. Selecting the Reset function after setting the equalizer resets the equalizer settings to 
the factory defaults.

Energy	Saving	→	Off	/	Low	/	Medium	/	High	/	Picture	Off	/	Auto
This feature adjusts the brightness of the TV in order to reduce power consumption. When watching TV at night, set the Energy 
Saving mode option to High to reduce eye fatigue as well as power consumption.
If you select Picture Off, the screen is turned off and you can only hear the sound. Press any button to get out of Picture Off.

In the Tools menu, Picture Off function is not supported.
Press the TOOLS button to display the Tools menu. You can also set the Energy Saving option by selecting Tools → Energy 
Saving.

Melody	→	Off	/	Low	/	Medium	/	High
A melody sound can be set to come on when the TV is powered On or Off.

The Melody does not play 
When no sound is output from the TV because the MUTE button has been pressed.
When no sound is output from the TV because the (–) Volume button has been pressed.
When the TV is turned off by Sleep Timer function.
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INPUT / SUPPORT

Configuring	the	Input	Menu

Source List
Use to select TV or other external input sources such as DVD / Blu-ray players / Satellite 
receivers (Set-Top Box) connected to the TV. Use to select the input source of your choice.

Press the SOURCE button on the remote control to view an external signal source. TV 
mode can be selected by pressing the TV button.

 TV / Ext. / AV / Component / PC / HDMI1/DVI / HDMI2 / HDMI3.
You can choose only those external devices that are connected to the TV. In the Source 
List, connected inputs will be highlighted and sorted to the top. Inputs that are not 
connected will be sorted to the bottom.
Ext. and PC Always stays activated.
Using the Colour buttons on the remote with the Source list

Red (Refresh): Refreshes the connecting external devices.
TOOLS (Tools): Displays the Edit Name and Information menus.

Edit Name
Name the device connected to the input jacks to make your input source selection easier.
VCR / DVD / Cable STB / Satellite STB / PVR STB / AV Receiver / Game / Camcorder / PC / DVI / DVI PC / TV / IPTV / Blu-ray 
/ HD DVD / DMA

When a PC with a resolution of 1920 x 1080 @ 60Hz is connected to the HDMI IN 1(DVI) port, you should set the HDMI1 
mode to DVI PC in the Edit Name of the Input mode.
When connecting an HDMI/DVI cable to the HDMI IN 1(DVI) port, you should set the HDMI1/DVI mode to DVI or DVI PC in 
the Edit Name of the Input mode. In this case, a separate sound connection is required.

Configuring	the	Support	Menu

Self Diagnosis
Picture Test
If you think you have a picture problem, perform the picture test. Check the colour pattern on 
the screen to see if the problem still exists.

Yes: If the test pattern does not appear or there is noise in the test pattern, select Yes. 
There may be a problem with the TV. Contact Samsung’s call centre for assistance.
No: If the test pattern is properly displayed, select No. There may be a problem with your 
external equipment. Please check your connections. If the problem still persists, refer to 
the external device’s user manual.

Sound Test
If you think you have a sound problem, please perform the sound test. You can check the sound by playing a built-in melody sound 
through the TV. ‘Does the problem still exist with this sound test?’ appears on the screen.

If you hear no sound from the TV’s speakers, before performing the sound test, make sure Speaker Select is set to TV speaker 
in the Sound menu.
The melody will be heard during the test even if Speaker Select is set to External Speaker or the sound is muted by pressing 
the MUTE button.
Yes: If during the sound test you can hear sound only from one speaker or not at all, select Yes. There may be a problem with 
the TV. Contact Samsung’s call centre for assistance.
No: If you can hear sound from the speakers, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual. 

Signal Information (digital channels only)
Unlike analogue channels, which can vary in reception quality from ‘snowy’ to clear, digital (HDTV) channels have either perfect 
reception quality or you will not receive them at all. So, unlike analogue channels, you cannot fine tune a digital channel. You can, 
however, adjust your antenna to improve the reception of available digital channels.

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to increase the signal strength. 
Continue to adjust the antenna until you find the best position with the strongest signal.
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Software Upgrade
To keep your product up-to-date with new Digital Television features then software upgrades 
are periodically broadcast as part of the normal Television signal. It will automatically detect 
these signals and display the software upgrade banner. You are given the option to install the 
upgrade.
BY USB
Insert a USB drive containing the firmware upgrade into TV. Please be careful to not 
disconnect the power or remove the USB drive while upgrades are being applied. The TV will 
turn off and turn on automatically after completing the firmware upgrade. Please check the firmware version after the update is 
completed. When software is upgraded, video and audio settings you have made will return to their default (factory) settings.
We recommend you write down your settings so that you can easily reset them after the upgrade.
BY Channel
Upgrades the software using the broadcasting signal.

If the function is selected during the software transmission period, this function searches for available software and downloads 
the software.
The time required to download the software is determined by the signal status.

Standby Mode Upgrade
To continue software upgrade with master power on, Select On by pressing the ▲ or ▼ button. 45 minutes after entering standby 
mode, a manual upgrade is automatically conducted. Since the power of the unit is turned on internally, the screen may be on 
slightly for the LCD product. This phenomenon may continue for more than 1 hour until the software upgrade is completed.
Alternative Software
To display the software version information.

HD Connection Guide
This menu presents the connection method that provides the optimal quality for the HD TV.
Refer to this information when connecting external devices to the TV.

Contact Samsung
View this information when your TV does not work properly or when you want to upgrade the software.
You can view the information regarding the call centre, product and software file download method.
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ANYNET+

Connecting Anynet+ Devices
Anynet+ is a function that enables you to control all connected Samsung devices that support Anynet+ with your Samsung TV’s 
remote.
The Anynet+ system can be used only with Samsung devices that have the Anynet+ feature. To be sure your Samsung device has 
this feature, check if there is an Anynet+ logo on it.

To connect to a TV

1.  Connect the HDMI IN (1(DVI), 2 or 3) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

To connect to Home Theatre

1.  Connect the HDMI IN (1(DVI), 2 or 3) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

2.  Connect the HDMI IN jack of the home theatre and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 
cable.
Connect the Optical cable between the DIGITAL AUDIO OUT (OPTICAL) jack on your TV and the Digital Audio Input on the 
Home Theatre.
When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from the Home 
Theatre’s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, connect the DIGITAL 
AUDIO OUT (OPTICAL) jack on the DVD / Blu-ray player or Cable/Satellite Box (ie Anynet Device 1 or 2) directly to the 
Amplifi er or Home Theatre, not the TV.
Connect only one Home Theatre.
You can connect an Anynet+ device using the HDMI 1.3 cable. Some HDMI cables may not support Anynet+ functions.
Anynet+ works when the AV device supporting Anynet+ is in the Standby or On status.
Anynet+ supports up to 12 AV devices in total. Note that you can connect up to 3 devices of the same type.

¦

N

N

N
N
N
N

TV

Optical Cable

Home Theatre

HDMI 1.3 Cable

Anynet+ Device 1

HDMI 1.3 Cable

Anynet+ Device 2 Anynet+ Device 3

HDMI 1.3 Cable

HDMI 1.3 
Cable

TV Anynet+ Device 1

HDMI 1.3 Cable

Anynet+ Device 2 Anynet+ Device 3

HDMI 1.3 Cable
HDMI 1.3 Cable

[530-Algiers]BN68-02396D-00L02.i24   24 2009-09-03   �� 4:56:12



English - 25

Setting Up Anynet+
Press the TOOLS button to display the Tools menu. You can also display Anynet+ menu 
by selecting Tools	→	Anynet+(HDMI-CEC).

Setup
Anynet+(HDMI-CEC)	→	Off / On
To use the Anynet+ Function, Anynet+ (HDMI-CEC) must be set to On.

When the Anynet+ (HDMI-CEC) function is disabled, all the Anynet+ related operations 
are deactivated.

Auto	Turn	Off	→	No	/	Yes
Setting an Anynet+ Device to turn Off Automatically when the TV is Turned Off

The active source on the TV remote must be set to TV to use the Anynet+ function.
If you set Auto Turn Off to Yes, connected external devices are also turned off when the 
TV is turned off. If an external device is still recording, it may or may not turn off.

Switching between Anynet+ Devices
1.  Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.  Press the ▲ or ▼ button to select Device List, then press the ENTERE button

Anynet+ devices connected to the TV are listed. If you cannot find a device you want, 
press the red button to scan for devices.
Only when you set Anynet+ (HDMI-CEC) to On in the Setup menu, the Device List 
menu appears.

3.  Press the ▲ or ▼ button to select a particular device and press the ENTERE button. It 
is switched to the selected device.
Switching to the selected devices may take up to 2 minutes. You cannot cancel the 
operation during the switching operation.
The time required to scan for devices is determined by the number of connected devices.
When the device scan is complete, the number of devices found are not displayed.
Although the TV automatically searches the device list when the TV is turned on via the power button, devices connected to 
the TV when the TV is on or under some conditions are not automatically displayed in the device list. Press the red button to 
search for the connected device.
If you have selected external input mode by pressing the SOURCE button, you cannot use the Anynet+ function. Make sure to 
switch to an Anynet+ device by using the Device List.

Anynet+ Menu
The Anynet+ menu changes depending on the type and status of the Anynet+ devices connected to the TV.

Anynet+ Menu Description
View TV Anynet+ mode changes to TV broadcast mode.
Device List Shows the Anynet+ device list.
(device_name) MENU Shows the connected device menus. E.g. If a DVD recorder is connected, the disc menu of the 

DVD recorder will appear.
(device_name) Operation Shows the play menu of the connected device. E.g. If a DVD recorder is connected, the play 

menu of the DVD recorder will appear.
Record: (*recorder) Starts recording immediately using the recorder. (This is only available for devices that support the 

recording function.)
Stop Recording: (*recorder) Stops recording.
Receiver Sound is played through the receiver.

If more than one recording device is connected, they are displayed as (*recorder) and if only one recording device is 
connected, it will be represented as (*device_name).
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TV Remote Control Buttons Available in Anynet+ Mode

Device Type Operating Status Available Buttons

Anynet+ Device

After switching to the device, when the 
menu of the corresponding device is 
displayed on the screen.

Numeric buttons
▲/▼/◄/►/ENTERE buttons
Colour buttons / EXIT button

After switching to the device, while playing 
a file

π(Backward search) / µ(Forward search) / ∫(Stop) / 
∂(Play) / ∑(Pause)

Device with built-
in Tuner

After switching to the device, when you 
are watching a TV programme P > / P < button

Audio Device When Receiver is activated Volume / MUTE button

The Anynet+ function only works when the active source on the TV remote control is set to TV.
The ∏ button works only while in the recordable state.
You cannot control Anynet+ devices using the buttons on the TV. You can control Anynet+ devices only using the TV remote 
control.
The TV remote control may not work under certain conditions. If this occurs, reselect the Anynet+ device.
The Anynet+ functions do not operate with other manufacturers’ products.
The π, µ operations may differ depending on the device.

Recording
You can make a recording of a TV programme using a Samsung recorder.
1.  Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.  Press the ▲ or ▼ button to select Record: (device_name), then press the ENTERE 

button. Recording begins.
When there is more than one recording device
When multiple recording devices are connected, the recording devices are listed. 
Press the ▲ or ▼ button to select a recording device and press the ENTERE 
button. Recording begins.
When the recording device is not displayed
Select Device List and press the red button to search devices.

3.  Press the EXIT button to exit.
You can record the source streams by selecting Record: (device_name).
Pressing the ∫ button will record whatever you are currently watching. If you are watching video from another device, the 
video from the device is recorded.
Before recording, check whether the antenna jack is properly connected to the recording device. To properly connect an 
antenna to a recording device, refer to the recording device’s users manual.

Listening through a Receiver (Home Theatre)
You can listen to sound through a receiver instead of the TV speaker.
1.  Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.  Press the ▲ or ▼ button to select Receiver. Press the ◄ or ► button to select On or Off.
3.  Press the EXIT button to exit.

If your receiver supports audio only, it may not appear in the device list.
The receiver will work when you have properly connected the optical in jack of the receiver to the DIGITAL AUDIO OUT 
(OPTICAL) jack of the TV.
When the Home Theatre receiver is set to On, you can hear sound output from the TV’s Optical jack. When the TV is 
displaying a DTV(air) signal, the TV will send out 5.1 channel sound to the Home theatre receiver. When the source is a digital 
component such as a DVD and is connected to the TV via HDMI, only 2 channel sound will be heard from the Home Theatre 
receiver.
If there is a power interruption to the TV when the Receiver is set to On (by disconnecting the power cord or a power failure), 
the Speaker Select may be set to External Speaker when you turn the TV on again. (see page 18)
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Troubleshooting for Anynet+

Problem Possible Solution
Anynet+ does not work. Check if the device is an Anynet+ device. The Anynet+ system supports Anynet+ devices only.

Connect only one receiver (home theatre).
Check if the Anynet+ device power cord is properly connected.
Check the Anynet+ device’s Video/Audio/HDMI 1.3 cable connections.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Check whether the TV remote control is in TV mode.
Check whether it is Anynet+ exclusive remote control.
Anynet+ doesn’t work in certain situations. (Searching channels, Operating Plug & Play, etc.)
When connecting or removing the HDMI 1.3 cable, please make sure to search devices again 
or turn your TV off and on again.
Check if the Anynet+ Function of Anynet+ device is set on.

●
●
●
●
●
●
●
●
●

●
I want to start Anynet+. Check if the Anynet+ device is properly connected to the TV and check if the Anynet+ (HDMI-

CEC) is set to On in the Anynet+ Setup menu.
Press the TV button on the TV remote control to switch to TV. Then press the TOOLS button 
to show the Anynet+ menu and select a menu you want.

●

●

I want to exit Anynet+. Select View TV in the Anynet+ menu.
Press the SOURCE button on the TV remote control and select a device other than Anynet+ 
devices.
Press P >/<, PRE-CH and FAV.CH to change the TV mode. (Note that the channel button 
operates only when a tuner-embedded Anynet+ device is not connected.)

●
●

●

The message Connecting to 
Anynet+ device... appears 
on the screen.

You cannot use the remote control when you are configuring Anynet+ or switching to a view 
mode.
Use the remote control when the Anynet+ setting or switching to view mode is complete.

●

●
The Anynet+ device does 
not play.

You cannot use the play function when Plug & Play is in progress.●

The connected device is not 
displayed.

Check whether or not the device supports Anynet+ functions.
Check whether or not the HDMI 1.3 cable is properly connected.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Search Anynet+ devices again.
You can connect an Anynet+ device using the HDMI 1.3 cable only. Some HDMI cables may 
not support Anynet+ functions.
If it is terminated by an abnormal situation such as disconnecting the HDMI cable or power 
cord or a power failure, please repeat the device scan.

●
●
●
●
●

●

The TV programme cannot 
be recorded.

Check whether the antenna jack on the recording device is properly connected.●

The TV sound is not output 
through the receiver.

Connect the optical cable between TV and the receiver.●

¦
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RECOMMENDATIONS FOR USE

Teletext Feature
Most television stations provide written information services via Teletext. The index page of the Teletext service gives you 
information on how to use the service. In addition, you can select various options to suit your requirements by using the remote 
control buttons.

For Teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or 
some pages may not be displayed.  
You can change Teletext pages by pressing the numeric buttons on the remote control.

1 0 (mode)
Press to select the Teletext mode 
(LIST/FLOF). If you press it in the LIST 
mode, it switches into the List save 
mode. In the List save mode, you can 
save Teletext page into list using the 
8(store) button.

2 5 (reveal)
Used to display the hidden text (answers 
to quiz games, for example). To display 
normal screen, press it again.

3 4 (size)
Press to display the double-size letters 
in the upper half of the screen. For 
lower half of the screen, press it again. 
To display normal screen, press it once 
again.

4 8 (store)
Used to store the Teletext pages.

5 Colour buttons (red/green/yellow/
blue)
If the FASTEXT system is used by a 
broadcasting company, the different 
topics covered on a Teletext page are 
colour-coded and can be selected by 
pressing the coloured buttons. Press 
one of them corresponding to the 
required. The page is displayed with 
other coloured information that can be 
selected in the same way. To display 
the previous or next page, press the 
corresponding coloured button.

6 / (Teletext on/mix)
Press to activate Teletext mode after 
selecting the channel providing the 
Teletext service. Press it twice to overlap 
the Teletext with the current broadcasting 
screen.

7 : (exit)
Exit from the Teletext display.

8 1 (sub-page)
Used to display the available sub-page.

9 2 (page up)
Used to display the next Teletext page.

0 3 (page down)
Used to display the previous Teletext 
page.

! 6 (index)
Used to display the index (contents) 
page at any time while you are viewing 
Teletext.

@ 9 (hold)
Used to hold the display on a given 
page if the selected page is linked with 
several secondary pages which follow on 
automatically. To resume, press it again.

# 7 (cancel)
Used to display the broadcast when 
searching for a page.

The Teletext pages are organized according to six categories:

Part Contents
A Selected page number.
B Broadcasting channel identity.
C Current page number or search indications.
D Date and time.
E Text.
F Status information.

FASTEXT information.
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Teletext information is often divided between several pages displayed in sequence, which can be accessed by:
Entering the page number
Selecting a title in a list
Selecting a coloured heading (FASTEXT system)

Teletext level supported by the TV is version 2.5 which is capable of displaying additional graphics or text.
Depending upon the transmission, blank side panels can occur when displaying Teletext.
In these cases, additional graphics or text is not transmitted.
Older TV’s which do not support version 2.5 are not capable of displaying any additional graphics or text, regardless of the 
Teletext transmission.
Press the TV button to exit from the Teletext display.
Teletext 16:9, picture is 16:9

Installing the Stand
Preset: Place the Guide Stand and Cover Neck onto the stand and fasten it using the 
screws. Applicable to 32inch models only.

1. Attach your LCD TV to the stand.
Two or more people should carry the TV.
Make sure to distinguish between the front and back of the stand when assembling 
them.
To make sure the TV is installed on the stand at a proper level, do not apply excess 
downward pressure to the upper left of right sides of the TV.

2. Fasten two screws at position 1 and then fasten two screw at position 2.
Stand the product up and fasten the screws. If you fasten the screws with the LCD TV 
placed down, it may lean to one side.

Installing the Wall Mount Kit

Wall mount items (sold separately) allow you to mount the TV on the wall.
For detailed information on installing the wall mount, see the instructions provided with the 
Wall Mount items. Contact a technician for assistance when installing the wall mounted 
bracket.
Samsung Electronics is not responsible for any damage to the product or injury to yourself or 
others if you elect to install the TV on your own.

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 
injury due to electric shock.
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Using the Anti-Theft Kensington Lock

The Kensington Lock is a device used to physically fix the system when using it in a public 
place. The appearance and locking method may differ from the illustration depending on the 
manufacturer. Refer to the manual provided with the Kensington Lock for proper use. The 
locking device has to be purchased separately. The location of the Kensington Lock may be 
different depending on its model.
1. Insert the locking device into the Kensington slot on the LCD TV (1) and turn it in the 

locking direction (2).
2. Connect the Kensington Lock cable (3).
3. Fix the Kensington Lock to a desk or a heavy stationary object.

3

1

2

Securing the Installation Space
Keep the required distances between the product and other objects (e.g. walls) to ensure proper ventilation. 
Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature of the product.
Install the product so the required distances shown in the figure are kept.

When using a stand or wall-mount, use parts provided by Samsung Electronics only.
If you use parts provided by another manufacturer, it may result in a problem with the product or an injury due to the 
product falling.
If you use parts provided by another manufacturer, it  may result in a problem with the product or fire due to an increase in 
the internal temperature of the product due to poor ventilation.

The appearance may differ depending on the product.

When installing the product with a stand When installing the product with a wall-mount

10 cm

10 cm

10 cm

10 cm

10 cm10 cm

10 cm

¦

¦

N




N

<Optional>
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Securing the TV to the Wall

Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. In particular, ensure your children do 
not hang over or destabilize the TV; doing so may cause the TV to tip over, causing serious injuries or death. 
Follow all safety precautions provided on the included Safety Flyer. For added stability, install the anti-fall device 
for safety purposes, as follows.

To avoid the TV from falling:
1. Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 

screws have been firmly installed onto the wall.
You may need additional material such as an anchor depending on the type of wall.
Since the necessary clamps, screws, and string are not supplied, please purchase 
these additionally.

2. Remove the screws from the centre back of the TV, put the screws into the clamps, and 
then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 
screws of the following specifications. 
Screw Specifications
For a 17 ~ 29 Inch LCD TV: M4 X L15 / For a 32 ~ 40 Inch LCD TV: M6 X L15

3. Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 
string and then tie the string tightly.

Install the TV near to the wall so that it does not fall backwards.
It is safe to connect the string so that the clamps fixed on the wall are equal to or 
lower than the clamps fixed on the TV.
Untie the string before moving the TV.

4. Verify all connections are properly secured. Periodically check connections for any 
sign of fatigue for failure. If you have any doubt about the security of your connections, 
contact a professional installer.

¦
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Troubleshooting
If you have any questions of TV, first refer to this list. If none of these troubleshooting tips apply, please visit ‘www.samsung.com’ 
site, then click on Support or contact Call Centre on list of last page.

Issue Solution

Picture Quality

First of all, please perform the Picture Test to confirm that your TV is properly displaying 
test image.

Go to MENU - Support - Self Diagnosis - Picture Test
If the test image is properly displayed, the poor picture may caused by the source or signal.
●

TV image does not look as good 
as it did in the store.

If you have an analogue Cable/Set top box, upgrade to an Box. Use HDMI or 
Component cables to deliver HD picture quality.
Cable/Satellite subscriber : Try HD(High Definition) stations from channel line up.
Antenna connection: Try HD stations after performing Auto programme.

Many HD channels are upscaled from SD(Standard Definition) contents.
Adjust Cable/Set top box video output resolution to 1080i or 720p.
Confirm that you are watching the TV at the minimum distance recomended based on 
the size and definition of the signal you are displaying.

●

●
●

N
●
●

Picture is distorted : macroblock, 
small block, dots, pixelization

Compression of video contents may cause picture distortion especially on fast moving 
pictures such as sports and action movies.
Low signal level or bad quality can cause picture distortion. This is not a TV issue.

●

●

Wrong or missing colour with 
Component connection.

Make sure the Component cables are connected to the correct jacks. Incorrect or loose 
connections may cause colour problems or the screen will be blank.

●

Poor colour or brightness. Adjust Picture options in the TV menu. (Picture mode, Colour, Brightness, 
Sharpness)
Adjust Energy Saving option in Setup menu.
Try picture reset to view the default picture setting. (Go to MENU - Picture - Picture 
Reset)

●

●
●

Dotted line on the edge of screen. If picture size is set to Screen Fit, change to 16:9.
Change cable/set top box resolution.

●
●

Picture is black and white with AV 
(Composite) input only.

Connect video cable(Yellow) to Green jack of component input 1 of the TV.●

Picture freezes or is distorted 
when changing channels or 
picture is delayed.

If connected with cable box, please try to reset cable box. (reconnect AC cord and wait 
until cable box reboots. It may take up to 20 minutes.)
Set output resolution of cable box to 1080i or 720p.

●

●

Sound Quality

First of all, please perform the Sound Test to confirm that your TV audio is properly 
operating.

Go to MENU - Support - Self Diagnosis - Sound Test
If the audio is OK, the sound problem may caused by the source or signal.
●

No sound or sound is too low at 
maximum volume.

Please check the volume of external device connected to your TV then, adjust the TV 
volume accordingly.

●

Picture is good but no sound. Set the Speaker Select option to TV speaker in the sound menu.
Make sure audio cables from an external device are connected to correct audio input 
jacks on the TV. 
Check connected device’s audio output option. (ex: You may need to change your 
cable box’ audio option to HDMI when you have HDMI connected to your TV.)
If you are using a DVI to HDMI cable, a separate audio cable is required.
Deactivate SRS function if you are setting the volume over 30 value.
Remove plug from headphone jack. (if available on your TV) 

●
●

●

●
●
●

Noise from speaker. Check cable connections. Make sure a video cable is not connected to an audio input.
For Antenna/Cable connection, check signal strength. Low signal level may cause 
sound distortion.

●
●

¦
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Issue Solution

No Picture, No Video

TV won’t turn on. Make sure the AC power cord is plugged in securely to the wall outlet and the TV.
Make sure the wall outlet is working.
Try pressing the POWER button on the TV to make sure the remote is working 
properly. If the TV turns on, it may be caused by Remote Control. To fix the Remote 
problem, refer to ‘Remote control does not work’ below.

●
●
●

TV turns off automatically. Check if the Sleep Timer is set to On in the Setup menu.
If connected the TV to your PC, check your PC power settings.
Make sure the AC power cord is plugged in securely to the wall outlet and the TV.
If there is no signal for about 10 ~ 15 minutes with Antenna/Cable connection, the TV 
will turn off.

●
●
●
●

No picture/Video. Check cable connections.(remove and reconnect all cables of TV and external devices)
Set your external device’s (Cable/Set top Box, DVD, Blu-ray etc) video output to match 
the connections to the TV input. For example, external device’s output: HDMI, TV’s 
input: HDMI.
Make sure your connected device is powered on.
Make sure to select the TV’s correct source by pressing the SOURCE button on the TV 
remote.

●
●

●
●

RF(Cable/Antenna) Connection

Cannot receive all channels. Make sure Antenna cable is connected securely.
Please try Plug & Play to add available channels to the channel list. Go to MENU - 
Setup - Plug & Play and wait for all avaiable channels are stored.
Verify Antenna is positioned correctly.

●
●

●

Picture is distorted: macroblock, 
small block, dots, pixelization

Compression of video contents may cause picture distortion especially on fast moving 
pictures such as sports and action movies.
Low signal level can cause picture distortion. This is not a TV issue.

●

●

PC Connection

‘Not Supported Mode’ message. Set your PC’s output resolution and frequency so it matches the resolutions supported 
by the TV.

●

PC is always shown on source list 
even if not connected.

This is normal; PC is always shown on the source list even though a PC is not 
connected.

●

Video is OK but there is no audio 
with HDMI connection.

Check the audio output setting on your PC.●
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Issue Solution

Others

Picture is not shown in full screen. Black bars on each side will be shown on HD channels when displaying upscaled SD 
(4:3) contents.
Black bars on Top & Bottom will be shown on movies that have aspect ratios different 
from your TV.
Adjust picture size option on your external device or TV to full screen.

●

●

●

Remote control does not work. Replace the remote control batteries with correct polarity (+ -).
Clean the transmission window located on the top of the remote.
Try pointing the remote directly at the TV from 5~6 feet away.

●
●
●

Can not control TV power or 
volume with Cable/Set top box 
remote control.

Programme the Cable/Set top box remote control to operate the TV. Refer to Cable/Sat 
user manual for SAMSUNG TV code.

●

‘Not Supported Mode’ message. Check the supported resolution of the TV and adjust the external device’s output 
resolution accordingly. Refer to resolution settings in this manual.

●

Plastic smell from TV. This smell is normal and will dissipate over time.●

TV Signal Information is 
unavailable in the Self Diagnostic 
Test menu.

This function is only available with digital channels with an Antenna (RF/Coax) 
connection.

●

TV is tilted to right or left side. Remove the stand base from TV and reassemble.●

Can not assemble stand base. Make sure TV is placed on flat surface. If can not remove screws from TV, please use 
magnetized screw driver.

●

Channel menu is grey out. 
(unavailable)

Channel menu is only available when TV source is selected.●

Your settings are lost after 30 
minutes or every time TV is 
turned off.

If TV is in the Store Demo mode, it will reset audio and picture settings every 30 
minutes. Please change from Store Demo mode to Home Use mode in the Plug & 
Play procedure. Press the SOURCE button to select TV mode, go to MENU → Setup 
→ Plug & Play → ENTERE.

●

Intermittent loss of audio or video. Check cable connections and reconnect. 
Can be caused by using overly rigid or thick cables. Make sure the cables are flexible 
enough for long term use. If wall mounting, we recommend using cables with 90 
degree connectors.

●
●

You may see small particles if you 
look closely at the edge of the 
bezel surrounding the TV screen.

This is part of the product’s design and is not a defect.●

‘Scramble signal’ or ‘Weak Signal/
No Signal’ with CAM CARD(CI).

Check that CAM has CI Card installed into the common interface slot.
Pull out CAM from the TV and insert into the slot again.

●
●

When turned off and 45 minutes 
later, TV is turned on itself.

It is normal, the TV operate OTA (Over The Air) function itself to upgrade firmware 
downloaded during watching.

●

Recurrent picture/sound issue. Check and change signal/source.●

This TFT LCD panel uses a panel consisting of sub pixels which require sophisticated technology to produce. However, there 
may be few bright or dark pixels on the screen. These pixels will have no impact on the performance of the product.

N
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Specifications

Model Name LE3�B530 LE40B530 LE46B530
Screen Size 
(Diagonal) 37 inch 40 inch 46 inch
PC Resolution
(Optimum) 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz
Sound
(Output) 10W x 2 10W x 2 10W x 2
Dimensions (WxDxH)
Body
With stand

918 X 77 X 597 mm
918 X 300 X 650 mm

998 X 78 X 621 mm
998 X 260 X 686 mm

1127 X 78 X 712 mm
1127 X 260 X 766 mm

Weight
With Stand 15 kg 18 kg 24 kg
Environmental 
Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
Left / Right -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.
This device is a Class B digital apparatus.
For the power supply and Power Consumption, refer to the label attached to the product.

¦

N
N
N
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Notifications pour le téléviseur numérique
1. Les fonctions relatives au téléviseur numérique (DVB) ne sont disponibles que dans les pays ou régions où des signaux 

terrestres numériques de type DVB-T (MPEG2 et MPEG4 AVC) sont diffusés ou dans lesquels vous avez accès à un service 
de télévision par câble compatible DVB-C (MPEG2 et MPEG4 AAC). Consultez votre distributeur local pour connaître les 
possibilités de réception des signaux DVB-T ou DVB-C.

2. DVB-T est la norme du consortium européen pour la diffusion de signaux terrestres de télévision numérique. La norme DVB-
C est quant à elle prévue pour la diffusion des signaux de télévision numérique par câble. Certaines fonctions particulières, 
telles que le guide électronique des programmes (Electric Program Guide - EPG), la vidéo à la demande (Video on Demand 
- VOD), etc., ne sont toutefois pas incluses dans cette spécification. Elles ne seront par conséquent pas traitées pour l'instant.

3. Bien que ce téléviseur soit conforme aux dernières normes DVB-T et DVB-C (août 2008), il n'est pas garanti qu'il soit 
compatible avec les futures diffusions de signaux numériques terrestres DVB-T et par câble DVB-C.

4. En fonction du pays ou de la région où vous vous trouvez, certains opérateurs de télévision par câble peuvent facturer des 
frais supplémentaires pour un tel service. Vous devrez aussi peut-être accepter les termes et conditions de ces sociétés.

5. Il se peut que certaines fonctions de TV numérique ne soient pas disponibles dans certains pays ou certaines régions et que 
la réception des signaux DVB-C ne soit pas correcte avec tous les opérateurs.

6.  Pour plus d'informations, contactez votre service client Samsung.

Précautions	à	prendre	lors	de	l'affichage	d'une	image	fixe	
Une image fixe peut occasionner des dommages irrémédiables à l'écran du téléviseur.

N'affichez pas d'image fixe ou partiellement fixe sur l'écran LCD pendant plus de 2 heures car cela pourrait provoquer 
une rémanence de l'image à l'écran. Cette rémanence de l'image est également appelée "brûlure de l'écran". Pour l'éviter, 
réduisez la luminosité et le contraste de l'écran lorsque vous affichez une image fixe.

L'affichage sur l'écran LCD du téléviseur d'images au format 4:3 pendant une période prolongée peut laisser 
des traces de bordures à gauche, à droite et au centre de l'écran, dues à la différence d'émission de lumière 
sur celui-ci. La lecture d'un DVD ou l'utilisation d'une console de jeu peut avoir un effet similaire sur l'écran. 
Les dommages occasionnés par l'effet précité ne sont pas couverts par la garantie.

L'affichage d'images fixes de jeux vidéo et d'ordinateurs pendant une période excessive peut produire des rémanences. Pour 
éviter cela, réduisez la "luminosité" et le "contraste" lors de l'affichage d'images fixes.  

© 2009 Samsung Electronics Co., Ltd. Tous droits réservés.

❑

❑

●

●

●

Les figures et illustrations contenues dans ce mode d’emploi sont fournies pour référence uniquement. Elles peuvent différer de 
l’aspect réel du produit.
La conception et les spécifications du produit sont susceptibles d’être modifiées sans préavis.
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Licence

TruSurround HD, SRS et le symbole  sont des marques de SRS Labs, Inc. La technologie TruSurround 
HD est incorporée sous licence de SRS Labs, Inc.

Fabriqué sous licence de Dolby Laboratories. Dolby et le symbole du double D sont des marques déposées 
de Dolby Laboratories.

Symboles 

N O T

Remarque Bouton tactile Bouton TOOLS Appuyez sur

❑

❑
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INFORMATIONS GÉNÉRALES

Présentation du panneau de commande
La couleur et la forme du produit peuvent varier en fonction du modèle.
Vous pouvez utiliser un bouton en appuyant sur les boutons du panneau latéral.

1 SOURCE E : Bascule entre toutes les sources d'entrée disponibles. Dans le menu à l'écran, utilisez ce bouton de la même 
façon que le bouton ENTERE de la télécommande.

2 MENU : Permet d'afficher un menu à l'écran des fonctions du téléviseur.
3 Y : Permet d'augmenter ou de baisser le volume. 

Dans le menu à l'écran, utilisez les boutons Y de la même façon que les boutons ◄ et ► de la télécommande.
4 Z : Permet de changer de chaîne. Dans le menu à l'écran, utilisez les boutons Z de la même façon que les 

boutons ▼ et ▲ de la télécommande.
5 P (ALIMENTATION) : Permet d'allumer et d'éteindre le téléviseur.
6 HAUT-PARLEURS
7 CAPTEUR DE LA TÉLÉCOMMANDE : Dirigez la télécommande vers ce point du téléviseur.
8 TÉMOIN D'ALIMENTATION : Clignote et s'éteint lorsqu'il est sous tension et s'allume en mode veille.

Accessoires

(M4 X L16)

Télécommande et piles 
(AAA x 2) Socle Vis de pied X 4 Chiffon de 

nettoyage Couvercle-Fond Câble 
d'alimentation

Manuel d’utilisation ● Carte de garantie● Manuel de sécurité●

Vérifiez que les éléments suivants sont fournis avec votre téléviseur LCD. S'il manque des éléments, contactez votre 
revendeur.
Carte de garantie / Manuel de sécurité (non disponible pour tous les pays)
La couleur et la forme des éléments peuvent varier en fonction du modèle.

¦

N
N

¦

N

N
N
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Présentation du panneau de branchement

La couleur et la forme du produit peuvent varier en fonction du modèle.
Lorsque vous branchez un périphérique externe sur votre téléviseur, assurez-vous que celui-ci est éteint. 
Lorsque vous branchez un périphérique externe, faites correspondre les couleurs de la borne de connexion et du câble.

1 DIGITAL AUDIO OUT (OPTICAL)
Pour raccorder un composant audio numérique tel qu'un récepteur home cinéma.
Lorsque les prises HDMI IN sont connectées, la prise DIGITAL AUDIO OUT (OPTICAL) du téléviseur produit uniquement 
un signal audio 2 voies. Pour écouter du son canal 5,1, branchez la prise optique du lecteur DVD / Blu-ray ou du 
décodeur câble/Décodeur satellite directement sur un amplificateur ou sur un système home cinéma, et non sur le 
téléviseur.

2 PC IN
Pour raccorder la fiche de sortie vidéo de votre PC.

3 ANT IN
Pour raccorder une antenne ou un système de câblodiffusion.

4 PC / DVI AUDIO IN
Pour raccorder la fiche de sortie audio de votre PC.
Sorties audio DVI pour périphériques externes.

5 AUDIO OUT [R-AUDIO-L]
Branchez les câbles audio RCA au connecteur AUDIO OUT [R-AUDIO-L] situé à l'arrière de votre poste et les autres 
extrémités aux connecteurs d'entrée audio correspondants sur l'amplificateur ou le système Home Cinéma.

6 Verrou KENSINGTON (en fonction du modèle)
Le verrou Kensington (en option) est un dispositif permettant de fixer physiquement le système en cas d'utilisation dans 
un lieu public. Si vous désirez utiliser un dispositif de verrouillage, contactez le revendeur auquel vous avez acheté le 
téléviseur.
L'emplacement du verrou Kensington peut varier en fonction du modèle. 

7 HDMI IN 1(DVI), 2, 3
Pour raccorder la fiche HDMI d'un périphérique équipé d'une sortie HDMI. 
Aucune connexion audio n'est nécessaire pour une connexion HDMI-HDMI.
Utilisez la prise HDMI IN 1(DVI) pour une connexion DVI à un périphérique externe. Utilisez un câble ou un adaptateur 
DVI-HDMI pour la connexion vidéo et les prises PC / DVI AUDIO IN pour le son.
Vous pouvez également utiliser les ports pour connecter un PC.
Qu'est-ce que HDMI ?
La technologie HDMI (High Definition Multimedia interface) permet la transmission de données vidéo numériques haute 
définition et de plusieurs canaux de son numérique.
Le terminal HDMI / DVI prend en charge la connexion DVI vers un périphérique raccordé avec le câble adéquat (non 
fourni). 
La différence entre HDMI et DVI est que le périphérique HDMI est plus petit, dispose de la fonction de codage HDCP 
(High Bandwidth Digital Copy Protection) et prend en charge le son numérique multicanal.
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[Panneau arrière du téléviseur]

Entrée de l'alimentation
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Il se peut que le téléviseur n'émette aucun son et que les images s'affichent dans des couleurs anormales en cas 
de connexion de lecteurs DVD / Blu-ray et décodeurs/récepteurs satellite compatibles avec des versions de HDMI 
antérieures à HDMI 1.3. Si, lorsque vous branchez un câble HDMI de génération antérieure, aucun son n'est émis, 
connectez le câble HDMI à la prise HDMI IN 1(DVI) et les câbles audio aux prises PC / DVI AUDIO IN situées à l'arrière 
du téléviseur. Dans ce cas, contactez la société ayant fourni le lecteur DVD / Blu-ray ou le décodeur câble / récepteur 
satellite afin de vérifier la version de HDMI, puis demandez une mise à jour du micrologiciel. Des câbles HDMI d'une 
version autre que 1.3 peuvent provoquer un scintillement à l'écran ou une absence totale d'image.

8 COMPONENT IN
Branchez les câbles vidéo de composant (en option) aux connecteurs de composant (PR, PB, Y) à l'arrière du téléviseur 
et les autres extrémités aux connecteurs de sortie vidéo de composant correspondants sur le récepteur DTV ou le lecteur 
DVD.
Si vous souhaitez brancher à la fois le boîtier décodeur et le récepteur DTV (ou lecteur DVD), vous devez brancher 
le boîtier décodeur au récepteur DTV (ou au lecteur DVD), puis le récepteur DTV (ou lecteur DVD) au connecteur de 
composant (PR, PB, Y) du téléviseur.
Les connecteurs PR, PB et Y de vos composants (récepteur DTV ou lecteur DVD) sont parfois désignés par les lettres Y, 
B-Y et R-Y ou Y, Cb et Cr.
Branchez les câbles audio RCA (en option) sur la prise [R-AUDIO-L]  à l'arrière du téléviseur et leur autre extrémité sur 
les prises de sortie audio correspondantes du récepteur DTV ou du lecteur DVD.

9 EXT (RGB)

Connecteur Entrée Sortie
Vidéo Audio (G / D) RVB Vidéo + Audio (G / D)

EXT O O O Seule la sortie TV ou DTV est disponible.
Entrées ou sorties pour périphériques externes tels que des magnétoscopes, des lecteurs DVD, des consoles de jeux 
vidéo ou des lecteurs de vidéodisques.

0 SERVICE
Connecteur pour mises à niveau logicielles.

! AV IN [VIDEO] / [R-AUDIO-L]
Branchez un câble RCA à un périphérique externe audio/vidéo approprié tel qu'un magnétoscope, un lecteur DVD ou un 
caméscope.
Branchez les câbles audio RCA sur la prise [R-AUDIO-L] du téléviseur et leur autre extrémité sur les prises de sortie 
audio correspondantes du périphérique audio/vidéo.

@ Emplacement COMMON INTERFACE
Si vous n'insérez pas la carte d'interface commune (CI CARD) dans certains canaux, le message "Scrambled Signal" 
s'affiche.
Les informations de pairage contenant un numéro de téléphone, l'ID de la CI CARD, l'ID de l'hôte et d'autres informations 
s'afficheront dans 2 ou 3 minutes. Si un message d'erreur s'affiche, contactez votre fournisseur de service.
Lorsque la configuration des informations sur les chaînes est terminée, le message "Updating Completed" s'affiche, 
indiquant que la liste des chaînes est à jour.
Vous devez vous procurer une CI CARD auprès d'un fournisseur local de câblodiffusion. Extrayez la CI CARD en la tirant 
délicatement. Une chute pourrait l'endommager.
Insérez la CI-Card dans le sens indiqué sur celle-ci.
L'emplacement de la fente COMMON INTERFACE peut varier en fonction du modèle. 
Il se peut que le module CAM ne soit pas pris en charge dans certains pays ou régions. Vérifiez auprès de votre 
revendeur agréé.
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Télécommande
Vous pouvez utiliser la télécommande jusqu'à une distance maximale d'environ 7 m du téléviseur.
Une lumière intense peut affecter le bon fonctionnement de la télécommande.
La couleur et la forme du produit peuvent varier en fonction du modèle.

1 POWER : Bouton de mise en veille 
du téléviseur.

2	 TOUCHES	NUMÉRIQUES :  
Permettent de changer de chaîne.

3 FAV.CH : Permet de basculer vers 
vos chaînes préférées.

4 Y : Permet d'augmenter ou 
de baisser le volume.

5 SOURCE : Permet d'afficher et 
de sélectionner les sources vidéo 
disponibles.

6 INFO  : Permet d'afficher des 
informations sur l'écran du 
téléviseur.

7 TOOLS : Permet de sélectionner 
rapidement les fonctions 
fréquemment utilisées.

8 CH LIST : Affiche la liste des 
chaînes.

9 BOUTONS DE COULEUR : Utilisez 
ces boutons dans les menus de 
Liste des chaînes, etc.

! DUAL : Sélection d'effets sonores.
@ Utilisez ces boutons dans les 

modes Anynet+. (∏ : vous 
pouvez utiliser cette télécommande 
pour contrôler l'enregistrement sur 
des enregistreurs Samsung offrant 
la fonctionnalité Anynet+.

# TV : Sélectionne directement le 
mode TV.

$ PRE-CH : Vous permet de revenir 
à la chaîne que vous regardiez 
précédemment.

% MUTEM : Vous permet de couper 
le son temporairement.

^ P </P > : Permet de changer de 
chaîne.

& MENU : Affiche le menu principal à 
l'écran.

* GUIDE : Affichage du guide électronique 
des programmes (EPG).

( RETURN : Revient au menu précédent
)	 HAUT▲	/	BAS▼	/	GAUCHE◄	/	

DROITE►	/	ENTERE : Permettent 
de sélectionner des options de menu 
à l'écran et de modifier des valeurs de 
menu.

a EXIT : Permet de quitter le menu.
b P.SIZE : Sélection du format d'image.
c SRS : Sélection de SRS TS HD.
d SUBT. : Affichage numérique des sous-

titres.
e AD : Sélection de la description audio.

Fonctions télétexte.
5 0 : Sélection du mode Télétexte (LIST/

FLOF).
6 5 : Activation du télétexte.
7 4 : Sélection de la taille du télétexte.
8 8 : Mémorisation du télétexte.
9 Sélection des rubriques Fastext
0 / : Sélection alternative de 

Teletext, Double ou Mix.
# : : fermer l'affichage du télétexte.
$ 1 : Page secondaire du télétexte.
^ 2 : Page de télétexte suivante

3 : Page de télétexte précédente.
& 6 : Index du télétexte
( 9 : Pause du télétexte.
a 7 : Annulation du télétexte.

Insertion des piles dans la télécommande
1. Soulevez le couvercle au dos de la télécommande comme illustré dans la figure.
2. Placez-y deux piles AAA. 

Assurez-vous que les pôles "+" et "–" des piles correspondent au schéma situé à 
l'intérieur du compartiment.

3. Replacez le couvercle.
Retirez les piles et stockez-les dans un endroit frais et sec si vous n'utilisez pas la 
télécommande pendant longtemps. 

Si la télécommande ne fonctionne pas, vérifiez les points suivants :
Le téléviseur est-il sous tension ? 
Les bornes + et - des piles ne sont-elles pas inversées ?
Les piles sont-elles déchargées ?
Le cordon d'alimentation est-il débranché ou y a-t-il une panne de courant ?
Une lampe fluorescente ou néon est-elle allumée à proximité ?

¦

N
N
N

¦
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N
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FONCTIONNEMENT

Affichage	des	menus
Avant d'utiliser le téléviseur, procédez comme suit pour apprendre à naviguer dans le menu 
afin de sélectionner et de régler les différentes fonctions.
1. Appuyez sur le bouton MENU.

Le menu principal s'affiche à l'écran. Son côté gauche contient des icônes : Image, Son, 
Canal, Conf., Entrée, Application, Assistance.

2.  Appuyez sur le bouton ▲ ou ▼ pour sélectionner l'une des icônes.
Appuyez sur le bouton ◄ ou ► pour accéder au sous-menu de l'icône.

3. Appuyez sur le bouton ▲ ou ▼ pour déplacer des options dans le menu.
Appuyez sur le bouton ENTERE pour entrer des options dans le menu.

4. Appuyez sur le bouton ▲/▼/◄/► pour modifier les options sélectionnées.
Appuyez sur le bouton RETURN pour revenir au menu précédent.

5. Appuyez sur le bouton EXIT pour quitter le menu.

Utilisation des boutons de télécommande
Bouton Opération Bouton Opération

MENUm Afficher le menu principal à l'écran.
▲/▼/◄/►/ 
ENTERE

Déplacer le curseur pour sélectionner un 
élément.
Choisir l'élément sélectionné.
Confirmer un paramétrage.

RUTURNR Revenir au menu précédent.

EXITe Fermer le menu affiché à l'écran.

Exemple	:	configuration	de	la	luminosité	du	téléviseur	dans	le	menu	Image

Réglage de la luminosité sur 80
1. Appuyez sur le bouton MENU pour afficher le menu. 

2. Appuyez sur le bouton ENTERE pour sélectionner Image. 

3. Appuyez sur le bouton ▲ ou ▼ pour régler la Luminosité.

4. Appuyez sur le bouton ENTERE. 

5. Appuyez sur le bouton ◄ ou ► jusqu'à ce que la luminosité soit réglée sur 80.
6. Appuyez sur le bouton ENTERE.

Appuyez sur le bouton EXIT pour quitter le menu.

¦

N



N
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Mode	 	 	 :	Standard	 ►
Rétroéclairage  : 7 

Contraste   : 95

Luminosité  : 45

Netteté   : 50

Couleur   : 50

Teinte (V / R)  : V50 / R50

Image

Mode	 	 	 :	Standard		 ►
Rétroéclairage  : 7 

Contraste   : 95

Luminosité  : 45

Netteté   : 50

Couleur   : 50

Teinte (V / R)  : V50 / R50

Image

Rétroéclairage  : 7 
Contraste   : 95

Luminosité	 	 :	45		 	 ►
Netteté   : 50

Couleur   : 50

Teinte (V / R)  : V50 / R50

Paramètres avancés

Options d'image

Réinitialisation de l'image

Image

U Déplacer   L Régler   E Entrer   R Retour

45Luminosité

U Déplacer   L Régler   E Entrer   R Retour

80Luminosité

Mode	 	 	 :	Standard		 ►
Rétroéclairage  : 7 

Contraste   : 95

Luminosité  : 45

Netteté   : 50

Couleur   : 50

Teinte (V / R)  : V50 / R50

Image
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Mise en mode veille de votre téléviseur
Vous pouvez mettre votre téléviseur en mode Veille afin de réduire la consommation électrique. Le mode veille peut être utile si 
vous souhaitez éteindre votre téléviseur temporairement (pendant un repas par exemple).
1. Appuyez sur le bouton POWERP de la télécommande.

L'écran s'éteint et un voyant de veille apparaît sur votre téléviseur.
2. Pour rallumer le téléviseur, appuyez de nouveau sur le bouton POWERP.

Ne laissez pas le téléviseur en mode Veille pendant de longues périodes (lorsque vous êtes en vacances par exemple). Il est 
conseillé de débrancher le téléviseur du secteur et de l'antenne.

Fonction Plug & Play
Lorsque vous allumez le téléviseur pour la première fois, des réglages de base s'effectuent l'un 
après l'autre de manière automatique.
1. Appuyez sur le bouton POWER de la télécommande. Le message You can set the menu 

language. s’affiche.
2. Sélectionnez la langue appropriée en appuyant sur le bouton ▲ ou ▼. Appuyez sur le 

bouton ENTERE pour confirmer votre choix.
3. Appuyez sur le bouton ◄ ou ► pour sélectionner Enr. démo ou Util. domicile, puis appuyez sur le bouton ENTERE. 

Nous recommandons de régler le téléviseur sur le mode Util. domicile pour une meilleure qualité d'image dans votre 
environnement personnel. 
Enr. démo n'est prévu que pour un usage en magasin. 
Si l'unité est accidentellement réglée sur le mode Enr. démo et que vous souhaitez revenir au mode Util. domicile 
(Standard) : Appuyez sur le bouton Volume du téléviseur. Lorsque l'affichage écran du volume apparaît, appuyez 
pendant 5 secondes sur le bouton MENU du téléviseur.

4. Appuyez sur le bouton ENTERE. Sélectionnez le pays approprié en appuyant sur le bouton ▲ ou ▼. Appuyez sur le bouton 
ENTERE pour confirmer votre choix.

5. Appuyez sur le bouton ▲ ou ▼ pour sélectionner Hertzien ou Câble, puis appuyez sur le bouton ENTERE.
Hertzien: Hertzien signal d'antenne.
Câble: Câble signal d'antenne.

6. Appuyez sur le bouton ▲ ou ▼ pour sélectionner la source de chaîne à mémoriser. Appuyez sur le bouton ENTERE pour 
sélectionner Démarrer.

Numérique et Analogique : Chaînes numériques et analogiques. 
Numérique : Chaînes numériques. 
Analogique : Chaînes analogiques.
Lors du réglage de la source d'antenne sur Câble, une fenêtre s'affiche, qui vous permet de définir une valeur pour la 
recherche de chaîne numérique. Pour plus d'informations, reportez-vous à Canal	→	Mémorisation	Auto.
La recherche de chaînes démarre et se termine automatiquement.
Certaines chaines peuvent ne pas être transmise à ce téléviseur. Cela dépend du signal de radiodiffusion ou de 
specification.
Appuyez sur le bouton ENTERE à tout moment pour interrompre la mémorisation.
Une fois toutes les chaînes disponibles mémorisées, le message Définit	le	mode	Horloge s'affiche.

�. Appuyez sur le bouton ENTERE. Appuyez sur le bouton ▲ ou ▼ pour sélectionner Auto., puis appuyez sur le bouton 
ENTERE.

Si vous sélectionnez Manuel,	Définit	la	date	et	l'heure s'affiche.
Si vous recevez un signal numérique, l'heure se règle automatiquement. Sinon, sélectionnez Manuel pour régler l'horloge 
(voir page 19).

8. La méthode de connexion pour l'obtention de la meilleure qualité HD est proposée. Après avoir confirmé la méthode, appuyez 
sur le bouton ENTERE.

9. Le message Profitez de votre téléviseur. s'affiche. Lorsque vous avez terminé, appuyez sur le bouton ENTERE.

Si vous souhaitez réinitialiser cette fonction...
1. Appuyez sur le bouton MENU pour afficher le menu. Appuyez sur le bouton ▲ ou ▼ pour sélectionner Conf., puis sur le 

bouton ENTERE.
2. Appuyez de nouveau sur le bouton ENTERE pour sélectionner Plug & Play. 
3. Entrez votre code PIN à quatre chiffres. Le code PIN par défaut d'un nouveau téléviseur est 0-0-0-0.

Si vous voulez modifier le code PIN, utilisez la fonction Modifier	PIN. (voir page 21).
La fonction Plug & Play est uniquement disponible en mode TV. 

¦

N

N

¦
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Plug & Play
You can set the menu language.

Menu Language  : English   ►

E Enter
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Visualisation	de	l’affichage
L’affichage identifie la chaîne en cours et l’état de certains paramètres audio et vidéo.

Appuyez sur le bouton INFO pour afficher les informations.

Appuyez sur le bouton INFO de la télécommande. La télévision affiche la chaîne, le type 
de son et l’état de certains paramètres de son et d’image.

▲, ▼: Vous pouvez afficher des informations relatives à une autre chaîne. Pour 
accéder à la chaîne actuellement sélectionnée, appuyez sur le bouton ENTERE.
◄, ►: Vous pouvez afficher les informations relatives au programme souhaité de la 
chaîne actuelle.
Appuyez de nouveau sur le bouton INFO ou attendez environ 10 secondes pour que 
l’affichage disparaisse automatiquement.

CONTRÔLE DES CHAÎNES

Configuration	du	menu	des	chaînes

Pays
L'écran de saisie du code PIN s'affiche. Entrez votre code PIN à quatre chiffres. 

Canal analogique
Permet de changer de pays pour les chaînes analogiques.
Canal numérique
Permet de changer de pays pour les chaînes numériques.

Mémorisation Auto
Vous pouvez chercher les plages de fréquence disponibles par balayage (leur disponibilité dépend de votre pays). Il est possible 
que les numéros de programme attribués automatiquement ne correspondent pas aux numéros de programme souhaités ou réels.

Si une chaîne est verrouillée par la fonction Verrouillage Canal, la fenêtre de saisie du code PIN s'affiche.
Hertzien / Câble
Source d'antenne à mémoriser

Numérique et Analogique : Chaînes numériques et analogiques. 
Numérique : Chaînes numériques. 
Analogique : Chaînes analogiques.

Lors de la sélection de ‘Câble	→	Numérique	et	Analogique’	ou	de	‘Câble	→	Numérique’
Fournissez une valeur à rechercher pour les chaînes câblées.

Mode	Rech.	→	Complet	/	Réseau	/	Rapide
Rapide

Network ID : affiche le code d'identification du réseau.
Fréquence : affiche la fréquence correspondant au canal (varie d'un pays à l'autre).
Modulation : affiche les valeurs de modulation disponibles.
Taux de symbole : affiche les débits de symboles disponibles.

–
–
–
–

Cherche toutes les chaînes avec des stations de diffusion actives et les enregistre dans la mémoire du téléviseur.
Pour arrêter la mémorisation automatique, appuyez sur le bouton ENTERE.
Le message Arrêter le programme automatique ? s'affiche.
Sélectionnez Oui en appuyant sur le bouton ◄ ou ►, puis appuyez sur le bouton ENTERE.

¦
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Pays	 		 	 	 	 ►
Mémorisation Auto

Mémorisation Manuelle

Option de recherche du câble

Guide Now & Next

Guide Complet

Par défaut  : Guide Complet

Canal

DTV Air

15
abc1

18:00 ~ 6:00 

18:11 Thu 6 Jan 

 Life On Venus Avenue
Unclassified
No Detaild Information  '   INFO
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Mémorisation Manuelle
Permet de chercher manuellement une chaîne et de l'enregistrer dans la mémoire du téléviseur.
Si une chaîne est verrouillée par la fonction Verrouillage Canal, la fenêtre de saisie du code PIN s'affiche.

Canal numérique
Enregistrement manuel de chaînes numériques.

Canal numérique est uniquement disponible en mode DTV.
Canal : Sélectionnez le numéro de chaîne à l'aide des boutons ▲, ▼ ou des chiffres (0~9).
Fréquence : Sélectionnez la fréquence à l'aide des chiffres.
Bande passante : Sélectionnez la bande passante à l'aide des boutons ▲, ▼ ou des chiffres (0~9).
Au terme de la recherche, les chaînes de la liste sont mises à jour.

Canal analogique
Enregistrement manuel de chaînes analogiques.

Programme (numéro de programme à attribuer à une chaîne) : Sélectionnez le numéro de chaîne à l'aide des boutons ▲, ▼ 
ou des touches numériques (0~9).
Système	de	Couleur	→	Auto.	/	PAL	/	SECAM	/	NTSC4.43 : Sélectionnez le système de couleurs à l'aide du bouton ▲ ou ▼.
Système	Sonore	→	BG	/	DK	/	I	/	L: Sélectionnez le système audio à l'aide du bouton ▲ ou ▼.
Canal (si vous connaissez le numéro de la chaîne à mémoriser) : Appuyez sur le bouton ▲ ou ▼ pour sélectionner  
C (chaîne hertzienne) ou S (chaîne câblée). Appuyez sur le bouton ►, puis sur le bouton ▲ ou ▼ ou un chiffre (0~9) pour 
sélectionner le numéro de votre choix.

Vous pouvez également sélectionner le numéro de chaîne directement en appuyant sur les touches numériques (0~9).
Si aucun son ne sort ou si le son produit est anormal, sélectionnez de nouveau la norme son requise.

Recherche (lorsque vous ne connaissez pas les numéros de chaîne) : Appuyez sur le bouton ▲ ou ▼ pour lancer la 
recherche. Le syntoniseur balaie la plage de fréquences jusqu'à ce que vous receviez la première chaîne ou la chaîne que 
vous avez sélectionnée à l'écran.
Enr. (permet de mémoriser la chaîne et le numéro de programme correspondant) : Sélectionnez OK en appuyant sur le 
bouton ENTERE.
Mode des chaînes

P (Mode Programme) : à la fin du réglage, des numéros de position compris entre P00 et P99 sont attribués aux stations 
de radiodiffusion de votre région. Dans ce mode, vous pouvez sélectionner un chaîne en saisissant son numéro de 
position.
C (Mode chaîne hertzienne) : dans ce mode, vous pouvez sélectionner une chaîne en saisissant le numéro attribué à 
chacune des stations de télédiffusion.
S (Mode chaîne câblée) : dans ce mode, vous pouvez sélectionner une chaîne en saisissant le numéro attribué à 
chacune des chaînes câblées.

Option de recherche du câble (en fonction du pays)
Définit des options supplémentaires telles que la fréquence et le débit de symboles pour les recherches sur réseau câblé.

Fréquence (Début ~ Fin) : affiche la fréquence correspondant au canal.
Modulation : affiche les valeurs de modulation disponibles.
Taux de symbole : affiche les débits de symboles disponibles.

Guide Now & Next / Guide Complet
Les informations relatives au guide électronique des programmes (EPG) sont fournies par les diffuseurs. Des entrées de 
programmes peuvent être vides ou ne pas être à jour en raison des informations diffusées sur un canal donné. L'affichage est 
automatiquement actualisé dès que de nouvelles informations sont disponibles.

Pour obtenir plus de détails sur les procédures d'utilisation du Guide Now & Next et Guide Complet, reportez-vous aux 
descriptions de la page 10.
Vous pouvez aussi afficher le guide en appuyant simplement sur le bouton GUIDE (pour configurer Par défaut, reportez-vous 
aux descriptions).

Guide Now & Next
Pour les six canaux indiqués dans la colonne de gauche, les informations relatives au programme actuel et au programme suivant 
sont affichées. 
Guide Complet
Affiche le programme heure par heure. Deux heures de programme sont affichées et vous pouvez faire défiler le programme en 
avançant ou en remontant dans le temps.
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Par	défaut	→	Guide	Now	&	Next	/	Guide	Complet
Vous pouvez choisir d'afficher le Guide Now & Next ou le Guide Complet lorsque vous appuyez sur le bouton GUIDE de la 
télécommande. 

Liste des chaînes
Pour obtenir plus de détails sur les procédures d'utilisation de la Liste des chaînes, reportez-vous aux instructions de Managing 
Channels.

Vous pouvez sélectionner ces options en appuyant sur le bouton CH LIST de la télécommande.

Mode Canal
Appuyez sur le bouton P >/<. L’ordre des chaînes affichées change.
Chaînes ajoutées
L’ordre des chaînes change dans la liste des chaînes mémorisées.
Favoris
L’ordre des chaînes change dans la liste des chaînes favorites.

Réglage	fin
Si la réception est claire, vous n'avez pas besoin d'effectuer une syntonisation fine du canal, car cette opération s'effectue 
automatiquement pendant la recherche et la mémorisation. Si le signal est faible ou distordu, vous pouvez être amené à effectuer 
manuellement une syntonisation fine du canal.

Les canaux finement syntonisés qui ont été mémorisés sont repérés par un astérisque "*" placé à droite de leur numéro dans 
la bannière des canaux.
Pour rétablir la syntonisation fine, sélectionnez Réin. à l'aide du bouton ▲ ou ▼, puis appuyez sur le bouton ENTERE. 
La syntonisation fine n'est possible que pour des chaînes analogiques.

Utilisation du Guide Now & Next / Guide Complet

Pour… Alors…
Regarder un programme de la liste du guide 
électronique des programmes

Sélectionnez un programme à l'aide des boutons ▲, ▼, ◄, ►.

Quitter le guide Appuyez sur le bouton bleu.
Si le programme suivant est sélectionné, il est planifié avec l'icône de l'horloge affichée. Si vous appuyez de nouveau sur le bouton 
ENTERE puis sur ◄, ► pour sélectionner Annuler progr., la programmation est annulée et l'icône de l'horloge disparaît. 
Voir les informations relatives aux programmes Sélectionnez un programme à l'aide des boutons ▲, ▼, ◄, ►. 

Appuyez ensuite sur le bouton INFO lorsque le programme de votre choix 
apparaît en surbrillance.
Le titre du programme se trouve dans la partie supérieure du centre de 
l'écran. 

Cliquez sur le bouton INFO pour obtenir des informations détaillées. Numéro de canal, temps de fonctionnement du programme, 
barre d'état, niveau de contrôle parental, informations sur la qualité vidéo (HD/SD), modes son, sous-titres ou télétexte, langue des 
sous-titres ou du télétexte et bref résumé du programme en surbrillance font partie des informations détaillées. “...” s'affiche si le 
résumé est long.
Choisissez entre Guide Now & Next et
Guide complet

Appuyez à plusieurs reprises sur le bouton rouge.

Dans le guide complet 
Reculer rapidement (24 heures). 
Avancer rapidement (24 heures).

Appuyez à plusieurs reprises sur le bouton vert.
Appuyez à plusieurs reprises sur le bouton jaune.
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❑
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Guide Complet
DTV Cable 900 f tn                               2:10  Mar 1 Jui
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Aujourd’hui 2:00 - 3:00 3:00 - 4:00

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

1       f tn
2       ITV Play
3       Kerrang!
4       Kiss
5       oneword
6       Smash Hits!▼

Street Hypn..

Kisstory
Aucune information.

Aucune information.

Aucune information.

Freshmen O..

 Regarder            INFO  Information        	■	Main/Aprés									■ +24 Heure								■ Quitter

Guide Now & Next
DTV Cable 900 f tn                               2:10  Mar 1 Jui
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Maintenant Suivant

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

1       f tn
2       ITV Play
3       Kerrang!
4       Kiss
5       oneword
6       Smash Hits!▼

Street Hypn..

Kisstory
Aucune information.

Aucune information.

Aucune information.

Freshmen O..

 Regarder             INFO  Information        	■	Guide Complet								■ Quitter
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Gestion des chaînes 
Ce menu permet d'ajouter/supprimer ou définir des chaînes favorites et d'utiliser le guide des 
programmes pour les émissions numériques.
Tous les canaux
Affiche toutes les chaînes actuellement disponibles.
Chaînes ajoutées
Affiche toutes les chaînes ajoutées.
Favoris
Affiche toutes les chaînes favorites.

Pour sélectionner les chaînes favorites que vous avez configurées, appuyez sur le bouton FAV.CH de la télécommande.
Programmé
Affiche tous les programmes actuellement réservés.

Sélectionnez une chaîne dans l'écran Tous les canaux, Chaînes ajoutées ou Favoris en appuyant sur les boutons ▲ / ▼, 
puis sur le bouton ENTERE. Vous pouvez alors regarder la chaîne sélectionnée.
Utilisation des boutons de couleur dans la liste des chaînes

Rouge (Type de canal) : permet de basculer entre TV, Radio, Donn/autre et Tous.  
Vert (Zoom) : Agrandit ou réduit un numéro de chaîne.
Jaune (Sélect.) : Sélectionne plusieurs listes de chaînes. Vous pouvez appliquer les fonctions d'ajout/suppression, 
d'ajout / suppression de favoris ou de verrouillage / déverrouillage à plusieurs chaînes à la fois. Sélectionnez les chaînes 
voulues, puis appuyez sur le bouton jaune pour traiter toutes les chaînes sélectionnées à la fois. La marque c s'affiche 
à gauche des chaînes sélectionnées.
TOOLS (Outils) : affiche le menu Supprimer (ou Ajouter), Ajouter aux favoris (ou Supprimer des favoris), Verrouil. 
(ou Déverr.), Rappel de prog., Modif. Nom Canal, Tri des canaux, Modif. numéro chaîne, Sélectionner tout, (ou  
Désélec. Tout), Mémorisation Auto. (Les menus Options peuvent varier en fonction de la situation.)

Icônes d'état des chaînes
A : Chaîne analogique.
c : Chaîne sélectionnée en appuyant sur le bouton jaune.
* : Chaîne définie comme favorite.
( : Programme en cours de diffusion.
\ : Chaîne verrouillée.
) : Programme réservé.

Menu d'options de la liste des chaînes (dans Tous les canaux / Chaînes ajoutées / Favoris)
Appuyez sur le bouton TOOLS pour utiliser le menu d'options.
Les éléments du menu Options peuvent varier selon l'état de la chaîne.

Ajouter / Supprimer
Vous pouvez supprimer ou ajouter une chaîne afin d'afficher les chaînes de votre choix.

Toutes les chaînes supprimées apparaîtront dans le menu Tous les canaux.
Une chaîne grisée est une chaîne qui a été supprimée. 
Le menu Ajouter s'affiche uniquement pour les chaînes supprimées.
Vous pouvez également ajouter une chaîne du menu Chaînes ajoutées ou Favoris de la 
même manière.

Ajouter aux favoris / Supprimer des favoris
Vous pouvez définir comme favorites les chaînes que vous regardez souvent.

Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également définir l'ajout aux (ou la suppression 
des) favoris en sélectionnant Outils	→	Ajouter	aux	favoris	(ou Supprimer des favoris).
Le symbole "*" s’affiche et la chaîne est définie comme favorite.
Toutes les chaînes favorites apparaîtront dans le menu Favoris.
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824                  UKTV Gold
825                  UKTV style

A  1             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --
A  7                  C --

Chaînes ajoutées
Tous      ■ Type de Canal         ■ Zoom         ■ Sélectionnez         T utils

824                  UKTV Gold
825                  UKTV style

A  1             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --
A  7                  C --

Chaînes ajoutées

Tous      ■ Type de Canal         ■ Zoom         ■ Sélection         T Outils

Supp.
Ajouter aux favoris
Verrouil.
Rappel de prog.
Modifi.	nom	de	chaîne
Tri des canaux

▼
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Verrouil. / Déverr.
Vous pouvez verrouiller une chaîne afin qu'elle ne puisse pas être sélectionnée ni visualisée. Cette fonction n'est disponible que si 
l'option Verr Parental est définie sur Marche (Voir page 21).

L'écran de saisie du code PIN s'affiche. Entrez votre code PIN à quatre chiffres. 
Le code PIN par défaut d'un nouveau téléviseur est 0-0-0-0. Vous pouvez modifier le code PIN en sélectionnant Modifier	PIN 
dans le menu.
Le symbole "\" s'affiche et la chaîne est verrouillée.

Rappel de prog.
Si vous réservez un programme que vous souhaitez regarder, la chaîne bascule automatiquement vers la chaîne réservée dans 
la liste de chaînes, même si vous êtes en train de regarder une autre chaîne. Pour réserver un programme, réglez d'abord l'heure 
actuelle (Voir page 19).

Il n'est possible de réserver que des chaînes mémorisées.
Vous pouvez régler directement la chaîne, le jour, le mois, l'heure et les minutes à l'aide des touches numériques de la 
télécommande.
Les programmes réservés apparaissent dans le menu Programme.
Guide	des	programmes	numérique	et	affichage	des	réservations
Quand une chaîne numérique est sélectionnée et que vous appuyez sur le bouton ►, le Guide des programmes de la chaîne 
s'affiche. Vous pouvez réserver un programme en suivant les procédures décrites ci-dessus.

Modifi.	nom	de	chaîne (chaînes analogiques uniquement)
Vous pouvez attribuer aux chaînes un libellé qui s'affiche chaque fois que vous les sélectionnez.

Les noms des chaînes numériques leur sont automatiquement attribués ; vous ne pouvez pas les modifier.
Modif. numéro chaîne (chaînes numériques uniquement)
Vous pouvez également modifier le numéro de chaîne à l'aide du pavé numérique de la télécommande.
Tri des canaux (chaînes analogiques uniquement)
Cette opération permet de changer les numéros de programme des chaînes mémorisées. Cette opération peut s'avérer 
nécessaire après l'utilisation de la mémorisation automatique.
Sélectionner tout / Désélectionner tout

Sélectionner Tout: Vous pouvez sélectionner toutes les chaînes de la liste des chaînes.
Désélec. Tout: Vous pouvez désélectionner toutes les chaînes sélectionnées.
La fonction Désélec. Tout n'est disponible que si au moins une chaîne est sélectionnée.

Mémorisation Auto
Pour plus d'informations sur le réglage des options, reportez-vous à la page 8.
Si une chaîne est verrouillée par la fonction Verr Parental, la fenêtre de saisie du code PIN s'affiche.

Menu d'options de la liste des chaînes (dans Programmé)
Vous pouvez voir, modifier ou supprimer une réservation.

Appuyez sur le bouton TOOLS pour utiliser le menu d'options.
Infos modif.
Permet de modifier une réservation.
Annuler progr.
Permet d'annuler une réservation.
Information
Permet de visualiser une réservation (et d'en modifier les informations).
Sélectionner tout
Permet de sélectionner tous les programmes réservés.
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1 / 1 / 2009

13:59 5 TV1  Quincy, M.E

18:59 2 TV3  The Equalizer

20:59 2 TV3  McMillan & Wife

Programmé

       Tous         ■ Zoom     ■ Sélection    T Outils    E Information 

Infos modif.
Annuler progr.
Information
Sélectionner tout
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CONTRÔLE D'IMAGE

Configuration	du	menu	Image

Mode
Vous pouvez sélectionner le type d'image correspondant le mieux à vos besoins d'affichage.

Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également 
définir le mode d'image en sélectionnant Outils	→	Mde	d'image.

Dynamique
Sélectionne l'image pour un affichage haute définition dans une pièce lumineuse.
Standard
Sélectionne l'image pour un affichage optimal dans un environnement normal.
Cinéma
Sélectionne l'image pour le visionnage de films dans une pièce sombre. 

Rétroéclairage / Contraste / Luminosité / Netteté / Couleur / Teinte (V/R)
Votre téléviseur offre de plusieurs options de paramétrage qui permettent de contrôler la 
qualité d'image.

Rétroéclairage : Règle la luminosité du rétroéclairage de l'écran LCD.
Contraste : Règle le niveau de contraste de l'image.
Luminosité : Règle le niveau de luminosité de l'image.
Netteté : Règle la définition des bords de l'image.
Couleur : Règle la saturation de couleur de l'image.
Teinte (V/R) : Ajuste la teinte de couleur de l'image.  
Sélectionnez un mode d'image à ajuster. Les valeurs ajustées sont enregistrées pour tous les modes d'image.
Lorsque vous modifiez les paramètres Rétroéclairage, Contraste, Luminosité, Netteté, Couleur ou Teinte (V/R), l'affichage 
à l'écran change en conséquence.
Dans les modes analogiques TV, Ext., AV du système PAL, vous ne pouvez pas utiliser la fonction Teinte (V/R).
En mode PC, vous ne pouvez modifier que les options Rétroéclairage, Contraste et Luminosité.
Vous pouvez régler et Mémoriser des paramètres pour chaque périphérique externe connecté à une entrée du téléviseur.
Vous pouvez réduire sensiblement l'énergie consommée en cours d'utilisation en baissant le niveau de luminosité de l'image, 
de façon à diminuer le coût de fonctionnement général.

Paramètres avancés
Les nouveaux téléviseurs Samsung permettent d'effectuer des réglages d'image encore plus précis que les modèles précédents. 
Le réglage des paramètres détaillés de l'image est expliqué ci-dessous.

Paramètres avancés est disponible dans les modes Standard et Cinéma.
En mode PC, vous ne pouvez modifier que les paramètres Gamma et Balance blancs parmi les options de menu 
Paramètres avancés.

Nuance	de	noir	→	Arrêt	/	Sombre	/	Plus	sombre	/	Le	plus	sombre
Vous pouvez choisir le niveau de noir pour régler la profondeur de l'écran.
Contraste	Dynam.	→	Arrêt	/	Bas	/	Moyen	/	Elevé
Vous pouvez régler le contraste de l'écran pour obtenir un résultat optimal.
Gamma
Vous pouvez régler l'intensité des couleurs primaires (rouge, vert, bleu).
Espace couleur
Espace couleur de Couleur est une matrice de couleurs composée de rouge, de vert et de bleu. Sélectionnez votre espace de 
couleur préféré et appréciez la couleur la plus naturelle.

Natif : offre une nuance de couleur profonde et riche.
Auto. : règle automatiquement la nuance de couleur la plus naturelle sur la base des sources de programme.
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Mode	 	 	 :	Standard		 ►
Rétroéclairage  : 7 

Contraste   : 95

Luminosité  : 45

Netteté   : 50

Couleur   : 50

Teinte (V / R)  : V50 / R50

Image

Couleur : 50
Teinte (V / R) : V50 / R50

Paramètres	avancés	 	 ►
Options d'image

Réinitialisation de l'image

Image
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Balance blancs
Vous pouvez régler la température des Couleur pour que celles-ci soient plus naturelles.

Aj. Rouge / Aj. Vert / Aj. Bleu / Regl. Rouge / Regl. vert / Regl. bleu : vous pouvez régler la température de couleur des 
zones claires en modifiant les valeurs R, G et B. Recommandé pour les utilisateurs avancés uniquement.
Réinit. : les valeurs par défaut de l'équilibrage du blanc réglé précédemment sont rétablies.

Carnation
Vous pouvez accentuer le "ton chair" de l'image.

La modification des valeurs de réglage actualise l'affichage à l'écran.
Netteté	des	contours	→	Arrêt	/	Marche
Vous pouvez faire ressortir les contours des objets dans l'image.

Options d'image
En mode PC, vous ne pouvez modifier que les paramètres Nuance Coul. et Taille parmi les options du menu Options 
d'image.

Nuance	Coul.	→	Froide	/	Normal	/	Chaude1	/	Chaude2
Vous pouvez sélectionner la nuance de couleur la plus agréable à l'œil.

Vous pouvez régler et enregistrer des paramètres pour chaque périphérique externe connecté à une entrée du téléviseur.
Chaude1 ou Chaude2 ne sont activées que si le mode d'image est Cinéma.

Taille
Vous pouvez sélectionner la taille d'image qui correspond le mieux à vos besoins d'affichage. 

Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également définir la taille en sélectionnant Outils 
→	Format	de	l’image.
Vous pouvez sélectionner ces options en appuyant sur le bouton P.SIZE de la télécommande.
16/9 auto : règle automatiquement la taille de l'image sur le format 16:9.
16:9 : règle la taille de l'image sur 16:9 de façon appropriée pour les DVD ou la diffusion au format cinémascope.
Zoom large : agrandit l'image à une taille supérieure à 4:3.
Zoom : agrandit l'image en 16:9 (dans le sens vertical) pour l'adapter à la taille de l'écran.
4:3 : paramètre par défaut pour un film vidéo ou une diffusion normale.
Adapter écran : Permet de voir l'intégralité de l'image sans coupure lors de l'entrée de signaux HDMI (720p / 1080i / 1080p) 
ou Composant (1080i / 1080p).
Les options de taille de l'image peuvent varier en fonction de la source d'entrée.
Les options disponibles peuvent varier en fonction du mode sélectionné.
En mode PC, seuls les modes 16:9 et 4:3 peuvent être réglés.
Vous pouvez régler et enregistrer des paramètres pour chaque périphérique externe connecté à une entrée du téléviseur.
Une rémanence temporaire peut se produire si vous affichez une image statique pendant plus de deux heures sur l'écran du 
téléviseur.
Zoom large : Appuyez sur le bouton ► pour sélectionner Position, puis appuyez sur le bouton ENTERE. Appuyez sur le 
bouton ▲ ou ▼ pour déplacer l'image vers le haut ou vers le bas. Appuyez ensuite sur le bouton ENTERE.
Zoom : Appuyez sur le bouton ► pour sélectionner Position, puis appuyez sur le bouton ENTERE. Appuyez sur le bouton 
▲ ou ▼ pour déplacer l'image vers le haut et vers le bas. Appuyez ensuite sur le bouton ENTERE. Appuyez sur le bouton 
► pour sélectionner Taille, puis appuyez sur le bouton ENTERE. Appuyez sur le bouton ▲ ou ▼ pour augmenter ou 
réduire la hauteur de l'image. Appuyez ensuite sur le bouton ENTERE.
Après avoir sélectionné l'option Adapter écran en mode HDMI (1080i / 1080p) ou Component (1080i / 1080p), sélectionnez 
Position à l'aide du bouton ◄ ou ►. Utilisez le bouton ▲, ▼, ◄ ou ► pour déplacer l'image.
Réinit. : Appuyez sur le bouton ◄ ou ► pour sélectionner Réinit., puis appuyez sur le bouton  ENTERE . Vous pouvez 
initialiser le réglage.
Si vous utilisez la fonction Adapter écran avec l'entrée HDMI 720p, une ligne sera coupée en haut, en bas, à gauche et à 
droite, comme avec la fonction Overscan.

Mode	écran	→	16:9	/	Zoom	large	/	Zoom	/	4:3
Lorsque vous réglez la taille de l'image sur 16/9 auto sur un téléviseur 16:9, vous pouvez déterminer la taille d'affichage d'une 
image 4:3 WSS (Wide Screen Service/service d'écran large) ou choisir de ne rien afficher pour ce format. Chaque pays européen 
impose une taille d'image différente ; cette fonction permet aux utilisateurs de sélectionner la leur.

16:9 : règle l'image en mode large, c'est-à-dire en 16:9.
Zoom large : agrandit l'image à une taille supérieure à 4:3.
Zoom : agrandit la taille de l'image sur l'écran dans le sens vertical.
4:3 : règle l'image en mode normal, c'est-à-dire en 4:3.
Cette fonction n'est disponible qu'en mode 16/9 auto.
Cette fonction n'est pas disponible en mode PC, Composant ou HDMI.
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NR	numérique	→	Arrêt	/	Bas	/	Moyen	/	Elevé	/	Auto.
Si le signal de radiodiffusion reçu est faible, vous pouvez activer la fonction Digital Noise Reduction pour faciliter la réduction 
d'images fantômes ou statiques qui peuvent apparaître à l'écran.

Lorsque le signal est faible, sélectionnez une autre option jusqu'à obtention de la meilleure image possible.
Niv.	noir	HDMI	→	Normal	/	Bas
Vous pouvez choisir le niveau de noir pour régler la profondeur de l'écran.

Cette fonction n'est active que si l'entrée externe se connecte à HDMI (signaux RVB).
Mode	Film	→	Arrêt	/	Auto.
Vous pouvez régler le téléviseur de sorte qu'il détecte et traite automatiquement les signaux de cinéma de toutes les sources et 
adapte l'image pour obtenir une qualité optimale.

Mode Film n'est prise en charge que dans TV, AV, COMPONENT(480i / 1080i) et HDMI(480i / 1080i).

Réinitialisation	de	l'image	→	Réinitial.	mode	image	/	Annuler
Rétablit tous les paramètres des images aux valeurs par défaut.

Sélectionnez un mode d'image à rétablir. La réinitialisation est effectuée pour chaque mode d'image.
Réinitial. mode image : rétablit les paramètres par défaut pour les valeurs de l'image actuelle.
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Utilisation de votre téléviseur comme écran d'ordinateur (PC)

Configuration	de	votre	logiciel	PC	(instructions	basées	sur	Windows	XP)
Les paramètres d'affichage Windows indiqués ci-dessous sont valables pour ordinateur standard. Les affichages écran sur 
votre PC seront probablement différents, en fonction de votre version de Windows et votre carte vidéo. Cependant, même si les 
affichages réels diffèrent, les mêmes informations de configuration de base s'appliquent dans la plupart des cas. Dans le cas 
contraire, contactez le fabricant de votre ordinateur ou votre revendeur Samsung.
1. Dans le menu Démarrer de Windows, cliquez sur "Panneau de configuration".
2. Dans le Panneau de configuration, cliquez sur "Apparence et thèmes". Une boîte de dialogue s'affiche.
3. Cliquez sur "Affichage". Une nouvelle boîte de dialogue s'affiche.
4. Cliquez sur l'onglet "Paramètres".

Réglage correct de la taille (résolution) : Optimal : 1920 x 1080 pixels.
S’il existe une option de fréquence verticale sur votre boîte de dialogue des paramètres d’affichage, la valeur correcte est "60" 
ou "60 Hz". Sinon, cliquez simplement sur "OK" pour quitter la boîte de dialogue.

¦
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Modes	d'affichage
La taille et la position de l'écran varient en fonction du type de moniteur du PC et de sa résolution. Les résolutions indiquées dans le 
tableau sont recommandées.

Entrée D-Secondaire et HDMI/DVI

Mode Résolution Fréquence horizontale 
(kHz)

Fréquence verticale 
(Hz)

Fréquence d'horloge 
pixels (MHz)

Polarité 
synchronisée 

(H/V)
IBM 640 x 350 31,469 70,086 25,175 +/-

720 x 400 31,469 70,087 28,322 -/+
MAC 640 x 480 35,000 66,667 30,240 -/-

832 x 624 49,726 74,551 57,284 -/-
1152 x 870 68,681 75,062 100,000 -/-

VESA CVT 720 x 576 35,910 59,950 32,750 -/+
1152 x 864 53,783 59,959 81,750 -/+
1280 x 720 44,772 59,855 74,500 -/+
1280 x 960 75,231 74,857 130,000 -/+
1280 x 720 56,456 74,777 95,750 -/+

VESA DMT 640 x 480 31,469 59,940 25,175 -/-
640 x 480 37,861 72,809 31,500 -/-
640 x 480 37,500 75,000 31,500 -/-
800 x 600 37,879 60,317 40,000 +/+
800 x 600 48,077 72,188 50,000 +/+
800 x 600 46,875 75,000 49,500 +/+

1024 x 768 48,363 60,004 65,000 -/-
1024 x 768 56,476 70,069 75,000 -/-
1024 x 768 60,023 75,029 78,750 +/+
1152 x 864 67,500 75,000 108,000 +/+

1280 x 1024 63,981 60,020 108,000 +/+
1280 x 1024 79,976 75,025 135,000 +/+
1280 x 800 49,702 59,810 83,500 -/+ 
1280 x 800 62,795 74,934 106,500 -/+ 
1280 x 960 60,000 60,000 108,000 +/+
1360 x 768 47,712 60,015 85,500 +/+
1440 x 900 55,935 59,887 106,500 -/+ 
1440 x 900 70,635 74,984 136,750 -/+

1680 x 1050 65,290 59,954 146,250 -/+ 
VESA GTF 1280 x 720 52,500 70,000 89,040 -/+ 

1280 x 1024 74,620 70,000 128,943 -/-
VESA DMT / 

DTV CEA 1920 x 1080p 67,500 60,000 148,500 +/+

Lorsque vous utilisez une connexion avec câble HDMI/DVI, vous devez utiliser la prise HDMI IN 1(DVI).
Le mode entrelacé n'est pas pris en charge.
Le téléviseur peut fonctionner de façon anormale si le format vidéo sélectionné n'est pas standard.
Les modes Séparé et Composite sont pris en charge. Le format SOG (SVSV) n'est pas pris en charge.
Un câble VGA trop long ou de qualité médiocre peut être source de parasites visuels dans les modes haute résolution  
(1920 x 1080 ou 1600 x 1200).

Configuration	du	téléviseur	avec	le	PC
Préréglage: Appuyez sur le bouton SOURCE pour sélectionner le mode PC.

Réglage Automatique
Le réglage automatique permet l'ajustement automatique de l'écran du PC affiché sur le 
téléviseur en fonction du signal vidéo entrant du PC. Les valeurs des options de réglage fin, de 
réglage de base et de position sont ajustées automatiquement.

Cette fonction ne s'applique pas en mode DVI-HDMI.
Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également 
définir le réglage automatique en sélectionnant Outils	→	Réglage	Automatique.

Ecran
Regl. Base / Regl. Prec
Lorsque vous réglez la qualité de l'image, l'objectif est d'éliminer ou de réduire les parasites visuels. Si vous ne pouvez pas 
éliminer ces parasites par une syntonisation fine, réglez la fréquence (Regl. Base) au mieux, puis effectuez de nouveau une 
syntonisation fine. Une fois les parasites réduits, effectuez un nouveau réglage de l'image pour l'aligner au centre de l'écran.
Position du PC
Réglez la position d'affichage du PC si elle ne convient pas pour l'écran du téléviseur. Appuyez sur le bouton ▲ ou ▼ pour régler 
la position verticale. Appuyez sur le bouton ◄ ou ► pour régler la position horizontale.
Réinitialiser Image
Vous pouvez rétablir les valeurs par défaut de tous les paramètres d'image.
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Luminosité  : 45
Netteté   : 50

Réglage	Automatique	 	 ►
Ecran 

Paramètres avancés 

Options d'image  

Réinitialisation de l'image 

Image
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CONTRÔLE DU SON

Configuration	du	menu	Sound

Mode	→	Standard	/	Musique	/	Cinéma	/	Voix	claire	/	Personnel
Vous pouvez sélectionner un mode son conforme à vos préférences.

Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également 
configurer le mode son en sélectionnant Outils → Mode Son.

Standard
Sélectionne le mode son normal.
Musique
Accentue la musique par rapport aux voix.
Cinéma
Offre le meilleur son pour les films.
Voix claire
Accentue les voix par rapport aux autres sons.
Personnel
Rétablit vos paramètres de son personnalisés.

Egaliseur
Vous pouvez régler les paramètres du son en fonction de vos préférences.
Mode
Vous pouvez sélectionner un mode son conforme à vos préférences.
Balance
Définit la balance entre les haut-parleurs droit et gauche.
100Hz / 300Hz / 1KHz / 3KHz / 10KHz (réglage de la bande passante)
Permet de régler le niveau de fréquences de la bande passante.
Réinit.
Rétablit les valeurs par défaut de l'égaliseur.

SRS	TruSurround	HD	→	Arrêt	/	Marche
Le SRS TruSurround HD est une technologie SRS brevetée qui remédie au problème de la lecture de contenu multicanal 5.1 sur 
deux haut-parleurs. Le TruSurround produit un son surround virtuel excellent au moyen de n'importe quel système de lecture à 
deux haut-parleurs, dont les haut-parleurs internes du téléviseur. Il est totalement compatible avec tous les formats multicanal.

Appuyez sur le bouton SRS de la télécommande pour sélectionner Arrêt ou Marche.

Langue audio (Chaînes numériques.)
Vous pouvez modifier la langue par défaut des sous-titres et de l'audio. Affiche les informations relatives à la langue pour le flux 
entrant.

Vous pouvez sélectionner la langue uniquement parmi les langues en cours de diffusion.
Cette fonction peut être sélectionnée pendant que vous regardez une chaîne numérique.

Format	Audio	→	MPEG	/	Dolby	Digital (Chaînes numériques.)
Lorsque le son est émis à la fois par le haut-parleur principal et le récepteur audio, un effet d'écho peut se produire en raison 
de la différence de vitesse de décodage entre le haut-parleur principal et le récepteur audio. Dans ce cas, utilisez la fonction TV 
Speaker (haut-parleur du téléviseur).

Le format audio s'affiche en fonction du signal diffusé.
Cette fonction peut être sélectionnée pendant que vous regardez une chaîne numérique.

Description audio (Chaînes numériques.)
Il s'agit d'une fonction audio auxiliaire qui fournit une piste audio supplémentaire à l'intention des personnes malvoyantes. Cette 
fonction traite le flux audio relatif à la description audio (AD) lorsqu'il est envoyé avec le son principal par le radiodiffuseur. Les 
utilisateurs peuvent activer ou désactiver la description audio et régler le volume.

Appuyez sur le bouton AD de la télécommande pour sélectionner Arrêt ou Marche.
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Mode	 	 	 :	Personnel	 ►
Egaliseur

SRS TruSurround HD : Arrêt

Langue audio  : - - -

Format Audio  : - - -

Description audio

Volume auto  : Arrêt

Son
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Description	audio	→	Arrêt	/	Marche
Active ou désactive la fonction de description audio.
Volume
 Permet d'ajuster le volume de la description audio.

Volume est actif lorsque Description audio est défini sur Marche .

Volume	auto	→	Arrêt	/	Marche	
Chaque station de télédiffusion possède ses propres conditions de signal. Il n'est donc pas facile de régler le volume chaque fois 
que vous changez de chaîne. Cette fonction permet de régler automatiquement le volume du canal désiré en réduisant la sortie 
son lorsque le signal de modulation est puissant ou en l'augmentant lorsque le signal est faible.

Sélection	Haut-parleur	→	Ht-parl	ext	/	Haut-parleur	TV
Pour entendre le son par l'intermédiaire d'enceintes séparées, désactivez l'amplificateur interne.

Les boutons de volume et MUTE ne fonctionnent pas lorsque la fonction Sélection Haut-parleur est réglée sur Ht-parl ext.
Si vous sélectionnez Ht-parl ext dans le menu Sélection Haut-parleur, les paramètres de son sont limités.

Réinitialisation	du	son	→	Réinitial.	tout	/	Réinitial.	mode	son	/	Annuler
Vous pouvez rétablir les valeurs par défaut des paramètres audio.

Sélection du mode son
Vous pouvez configurer le mode sonore en appuyant sur le bouton DUAL. Lorsque vous appuyez sur ce bouton, le mode
sonore courant s’affiche à l’écran.

Type d'audio Dual 1 / 2 Par défaut

Stéréo A2
Mono MONO

Changement automatique
Stéréo STEREO	↔	MONO
Double DUAL	1	↔	DUAL	2 DUAL 1

NICAM 
Stéréo

Mono MONO
Changement automatique

Stéréo MONO	↔	STEREO

Double MONO	↔	DUAL	1	
DUAL 2 DUAL 1

Si le signal stéréo est faible et qu'une commutation automatique se produit, passez alors en Mono.
Cette fonction n'est activée qu'en son stéréo. Elle est désactivée en mode mono.
Cette fonction n'est disponible qu'en mode TV.
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Configuration

Configuration	du	menu	Configuration

Langue des menus
Permet de définir la langue des menus.

Horloge
Horloge
Le réglage de l'horloge est nécessaire pour utiliser les différentes fonctions de minuterie de la 
télévision.

L'heure actuelle s'affiche chaque fois que vous appuyez sur le bouton INFO.
Si vous débranchez le cordon d'alimentation, vous devez régler de nouveau l'horloge.
Mode Horloge
L'heure en cours peut être réglée manuellement ou automatiquement.

Auto. : Définit l'heure en cours automatiquement en utilisant l'heure de la transmission numérique.
Manuel : Définit l'heure en cours d'après l'heure entrée manuellement.
En fonction de la station de diffusion et du signal diffusé, il se peut que l'heure ne soit pas réglée correctement. Si cela se 
produit, réglez l'heure manuellement. 
Pour que l'heure soit réglée automatiquement, l'antenne ou le câble doit être connecté.

Réglage Horloge
Vous pouvez définir l'heure en cours manuellement.

Activez cette option lorsque Mode Horloge est défini sur Manuel.
Vous pouvez régler directement le jour, le mois, l'année, l'heure et la minute en appuyant sur les touches numériques de 
la télécommande.

Veille	→		Arrêt	/	30	min	/	60	min	/	90	min	/	120	min	/	150	min	/	180	min
La minuterie de mise en veille éteint automatiquement la télévision après une durée préréglée (30, 60, 90, 120, 150 ou 180 
minutes).

Le téléviseur passe automatiquement en mode veille lorsque la minuterie atteint 0.
Pour annuler la fonction Veille, sélectionnez Arrêt.
Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également régler la minuterie de mise en veille en 
sélectionnant Outils	→	Veille.

Minuteur 1 / Minuteur 2 / Minuteur 3
Vous pouvez effectuer trois paramétrages différent de la minuterie de marche/arrêt. Vous devez d'abord régler l'horloge.

Période d'activation : Sélectionnez l'heure, la minute et l'action activer/désactiver (Pour activer le minuteur selon les réglages 
définis, choisissez Activer.)
Période de désactivation : Sélectionnez l'heure, la minute et l'action activer/désactiver (Pour activer le minuteur selon les 
réglages définis, choisissez Activer.)
Volume : Sélectionnez le niveau de volume à la mise sous tension.
Antenne : Sélectionnez Hertzien ou Câble.
Canal : Sélectionnez la chaîne désirée.
Répétition : Sélectionnez Une fois, Ts jours, Lun~Ven, Lun~Sam, Sam~Dim ou Manuel.

Lorsque Manuel est sélectionné, appuyez sur le bouton ► pour sélectionner le jour de la semaine. Appuyez sur le bouton 
ENTERE sur le jour de votre choix. Le symbole c s'affiche alors.

Vous pouvez régler l'heure, la minute et la chaîne directement à l'aide des touches numériques de la télécommande.
Mise hors tension automatique
Lorsque vous réglez la minuterie sur ON, le téléviseur s'éteint si aucune commande n'est utilisée dans les 3 heures qui 
suivent la mise sous tension par le minuteur. Cette fonction est disponible uniquement lorsque la minuterie est réglée sur ON ; 
elle permet d'éviter toute surchauffe occasionnée par une utilisation prolongée du téléviseur.
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Plug & Play 

Langue des menus :	Français	 ►
Horloge

Diffuser

Sécurité

Général
Configuration
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Diffuser
Sous-titres
Vous pouvez activer ou désactiver les sous-titres. Utilisez ce menu pour définir le mode des sous-titres. Normal sélectionne les 
sous-titres de base ; Malentendants sélectionne les sous-titres pour personnes malentendantes.

Sous-titres	→	Arrêt	/	Marche:	Active/désactive les sous-titres.
Mode	→	Normal	/	Malentendants: Sélectionne le mode de la fonction Sous-titres.
Langue des sous-titres: définit la Langue des sous-titres
Si le programme visionné n'offre pas de fonction Malentendants, le mode Normal est automatiquement activé, même si le 
mode Malentendants est sélectionné.
L'anglais est la langue par défaut si la langue sélectionnée n'est pas diffusée.
Vous pouvez sélectionner ces options en appuyant sur le bouton SUBT. de la télécommande.

Texte	numérique	→	Désactiver	/	Activer	(Royaume-Uni	uniquement)
Si le programme est diffusé avec du texte numérique, cette fonction est activée.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)
Norme internationale pour les systèmes de codage des données utilisés avec le multimédia et l'hypermédia. Niveau supérieur 
à celui du système MPEG, qui inclut de l'hypermédia à liaison de données tel que des images fixes, le service de caractères, 
l'animation, les fichiers graphiques et vidéo et les données multimédia. MHEG est une technologie d'interaction de l'utilisateur 
en cours d'utilisation appliquée à divers domaines, dont la vidéo à la demande (VOD), la télévision interactive (ITV), le 
commerce électronique, la téléformation, la téléconférence, les bibliothèques numériques et les jeux en réseau.

Langue du télétexte
Vous pouvez Sélectionne la langue du télétexte par type de langue.

L'anglais est la langue par défaut si la langue sélectionnée n'est pas diffusée.

Préférence
Première Langue Audio / Deuxième Langue Audio / Langue princ. sous-titres / Langue sec. sous-titres / Première 
Langue Télétexte / Deuxième Langue Télétexte 
Cette fonction permet de sélectionner une des langues disponibles. La langue sélectionnée ici est la langue par défaut de la 
chaîne sélectionnée.
Si vous changez la langue, les options Subtitle Language, Audio Language et Teletext Language du menu Language sont 
automatiquement modifiées en conséquence.
Les options Subtitle Language, Audio Language et Teletext Language du menu Language présentent une liste des langues 
prises en charge par la chaîne actuelle et la langue sélectionnée est affichée en surbrillance. Si vous modifiez le paramètre de 
la langue, la nouvelle sélection n'est valable que pour la chaîne actuelle. Le nouveau paramétrage n'affecte pas le réglage des 
options Primary Subtitle Language, Primary Audio Language ou Primary Teletext Language du menu Preference.

Interface commune
CI Menu
Permet à l'utilisateur d'opérer une sélection dans le menu du module CAM. 
Sélectionnez le menu CI Menu le menu PC Card.
Infos sur l’application
Contient des informations sur le module CAM inséré dans la fente CI et les affiche. 

Les informations sur l'application concernent la CI CARD. Vous pouvez installer le module CAM que le téléviseur soit 
allumé ou Arrêt

1. Achetez le module CI CAM chez le revendeur le plus proche ou par téléphone.
2. Insérez la CI CARD dans le module CAM, dans le sens indiqué par la flèche, jusqu'à ce qu'elle se loge en place.
3. Insérez le module CAM avec la CI CARD installée dans la fente de l'interface commune. 
 (Insérez le module CAM dans le sens indiqué par la flèche, à fond, de façon à ce qu'il soit parallèle à la fente.)
4. Vérifiez si une image est visible sur une chaîne à signal brouillé.

Il se peut que le module CAM ne soit pas pris en charge dans certains pays ou régions. Vérifiez auprès de votre 
revendeur agréé.
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Sécurité
L'écran de saisie du code PIN s'affiche avant l'écran de configuration. Entrez votre code PIN à quatre chiffres. Le code PIN par 
défaut d’un nouveau téléviseur est 0-0-0-0. Vous pouvez modifier le code PIN en sélectionnant Modifier	PIN dans le menu.

Verrouillage	Canal	→	Arrêt	/	Marche	
Cette fonction permet d'empêcher que des utilisateurs non autorisés, tels que des enfants, regardent des programmes 
inappropriés, en désactivant la vidéo et l'audio.

Vous pouvez verrouiller certaines chaînes dans la liste des chaînes. (voir page 12).
Verrouillage Canal est uniquement disponible en mode TV.

Verrouillage parental
Cette fonction permet d'empêcher certains utilisateurs, par exemple des enfants, de regarder des émissions inappropriées, en les 
protégeant à l'aide d’un code de 4 chiffres défini par l'utilisateur.

L’option Verrouillage parental diffère en fonction du pays.
Lorsque le Verrouillage parental est activé, le symbole ‘\’ s’affiche.
Autor.tout : appuyez sur ce bouton pour déverrouiller toutes les évaluations TV.
Bloq. tout : appuyez sur ce bouton pour verrouiller tous les classements TV.

Modifier PIN
Vous pouvez modifier le code personnel demandé pour pouvoir configurer le téléviseur.

Si vous avez oublié le code, appuyez sur les boutons de la télécommande dans l'ordre suivant, ce qui remet le code à  
0-0-0-0 : POWER (Arrêt) → MUTE → 8 → 2 → 4 → POWER (Marche).

Général

Mode	Jeu	→	Arrêt	/	Marche	
En reliant le téléviseur à une console de jeu telle que PlayStation™ ou Xbox™, vous pouvez profiter d'une expérience de jeu plus 
réaliste en sélectionnant le menu de jeu.

Pour déconnecter la console de jeu et connecter un autre périphérique externe, annulez le mode Jeu dans le menu de configuration.
Si vous affichez le menu du téléviseur en mode "Mode Jeu", l'écran vacille légèrement.
Mode Jeu n'est pas disponible en mode TV et PC normal.
Si le Mode Jeu est activé :

Le mode Picture bascule automatiquement sur Standard et les utilisateurs ne peuvent pas changer de mode.
Le mode Sound bascule automatiquement sur Personnel et les utilisateurs ne peuvent pas changer de mode. Réglez le 
son à l'aide de l'égaliseur.

La fonction Régler du menu Son est activée. Sélectionner la fonction Reset après avoir réglé l’égaliseur rétablit ses 
paramètres par défaut.

Mode	éco.	→	Arrêt	/	Bas	/	Moyen	/	Elevé	/	Image désactivée / Auto.
Cette fonction règle la luminosité du téléviseur afin de réduire la consommation d'énergie. Lorsque vous regardez la télévision le 
soir, réglez l'option du mode Mode éco. sur Elevé pour reposer vos yeux et réduire la consommation d'énergie.
Si vous sélectionnez Image désactivée, l’écran s’éteint. Seul le son est émis. Appuyez à nouveau sur ce bouton pour désactiver 
la fonction Image désactivée.

La function Image désactivée n’est pas prise en charge dans le menu Tools.
Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également définir l'option d'économie d'énergie en 
sélectionnant Outils → Mode éco..

Mélodie	→	Arrêt	/	Bas	/	Moyen	/	Elevé
Il est possible de programmer la lecture d'une mélodie lors de la mise sous tension ou hors tension du téléviseur.

Aucune mélodie n'est lue dans les cas suivants : 
Aucun son n'est émis par le téléviseur parce que le bouton MUTE a été actionné.
Aucun son n'est émis par le téléviseur parce que le bouton (–) Volume a été actionné.
Lorsque le téléviseur est mis hors tension par la fonction de veille.
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Entrée / Assistance

Configuration	du	menu	Input

Liste Source
Permet de sélectionner le téléviseur ou d'autres sources d'entrée externes telles que des 
lecteurs DVD/Blu-ray ou des récepteurs satellite (boîtiers décodeurs) connectées au téléviseur. 
Permet de sélectionner la source d'entrée de votre choix.

Appuyez sur le bouton SOURCE de la télécommande pour afficher une source de signal 
externe. Une pression sur le bouton TV sélectionne le mode TV.

TV / Ext. / AV / Composant / PC / HDMI1 / DVI / HDMI2 / HDMI3
Vous ne pouvez sélectionner que des périphériques externes connectés au téléviseur. 
Dans Liste Source, les entrées connectées s'affichent en surbrillance en début de liste. 
Les entrées non connectées s'affichent en bas de liste.
Les options Ext. et PC sont toujours activées.
Utilisation des boutons de couleur de la télécommande dans la liste des sources

Rouge (Rafraîchir) : Actualise la liste des périphériques externes connectés.
TOOLS (Outils) : Affiche les menus Modif. Nom et Information.

Modif. Nom
Nommez le périphérique connecté aux prises d'entrée pour faciliter la sélection de source d'entrée.
Magnétoscope / DVD / Décodeur Câble / Décodeur satellite / Décodeur PVR / Récepteur AV / Jeu / Caméscope / PC / DVI / 
DVI PC / TV / IPTV/ Blu-ray / HD DVD / DMA

Si un PC d'une résolution de 1920 x 1080 à 60 Hz est connecté au port HDMI IN 1(DVI), vous devez régler le mode  
HDMI1/DVI sur DVI PC dans le champ Modif. Nom du mode Entrée.
Si vous connectez un câble HDMI/DVI au port HDMI IN 1(DVI), vous devez régler le mode HDMI1/DVI sur DVI ou DVI PC 
dans le champ Modif. Nom du mode Entrée. Dans ce cas, une connexion audio séparée est indispensable.

Configuration	du	menu	Support

Diagnostic automatique
Test de l’image
Si vous pensez que l'image n'est pas optimale, exécutez le test d'image. Vérifiez la mire de 
couleur à l'écran pour voir si le problème persiste.

Oui : si la mire de couleur n'apparaît pas où si elle est parasitée, sélectionnez Oui. Il se 
peut que le téléviseur soit défaillant. Demandez de l'aide au centre d'appel de Samsung.
Non: si la mire de couleur s'affiche correctement, sélectionnez Non. Il se peut que 
l'équipement externe soit défaillant. Vérifiez les connexions. Si le problème persiste, 
reportez-vous au mode d'emploi du périphérique externe.

Test du son
Si vous pensez que le son n'est pas optimal, exécutez le test du son. Vous pouvez contrôler le 
son en diffusant une mélodie préenregistrée sur le téléviseur. Le message "Le problème persiste-t-il pour ce test du son?" s'affiche 
à l'écran.

Si les haut-parleurs du téléviseur restent muets, avant d'effectuer le test du son, vérifiez que l'option Sélection Haut-parleur 
est réglée sur Haut-parleur TV dans le menu Sound.
La mélodie est diffusée pendant le test, même si l'option Sélection Haut-parleurt est réglée sur Ht-parl ext ou si le son a été 
désactivé en appuyant sur le bouton MUTE.
Oui : si, pendant le test du son, vous n'entendez du son que d'un haut-parleur ou pas de son du tout, sélectionnez Oui. Il se 
peut que le téléviseur soit défaillant. Demandez de l'aide au centre d'appel de Samsung.
Non : Si vous entendez du son des haut-parleurs, sélectionnez Non. Il se peut que l'équipement externe soit défaillant. 
Vérifiez les connexions. Si le problème persiste, reportez-vous au mode d'emploi du périphérique externe. 

Informations de signal (chaînes numériques uniquement)
À l'inverse des chaînes analogiques, dont la qualité de réception peut varier de "neigeuse" à claire, les chaînes numériques 
(HDTV) présentent une qualité de réception parfaite ou bien vous ne les recevez pas. Contrairement aux chaînes analogiques, 
vous ne pouvez donc pas syntoniser une chaîne numérique. Vous avez toutefois la possibilité de régler votre antenne pour 
améliorer la réception des chaînes numériques disponibles.

Si l'indicateur d'intensité du signal indique que celui-ci est faible, réglez physiquement votre antenne afin d'en augmenter 
l'intensité. Continuez à régler l'antenne jusqu'à ce que trouver la position offrant le signal le plus puissant.
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Mise à niveau du logiciel
Pour garder le produit à jour avec les nouvelles fonctions de télévision numérique, des mises 
à jour logicielles sont régulièrement diffusées via le signal de télévision normal. Le téléviseur 
détecte automatiquement ces signaux et affiche la bannière de mise à jour logicielle. Vous 
avez le choix d'installer ou non la mise à jour.
USB
Insérez dans le téléviseur un lecteur USB contenant la mise à niveau du microprogramme. 
Veillez à ne pas couper l'alimentation ni retirer le lecteur USB pendant l'application des 
mises à niveau. Une fois la mise à niveau du micrologiciel terminée, le téléviseur se met 
automatiquement hors puis sous tension. Vérifiez la version du micrologiciel une fois les mises 
à jour terminées. Lorsque le logiciel est mis à niveau, les paramètres vidéo et audio définis 
reprennent leur valeur par défaut (usine).
Il est recommandé de noter les paramétrages afin de pouvoir les rétablir facilement après la mise à niveau.
Canal
Mise à niveau du logiciel à l'aide du signal de diffusion.

Si elle est sélectionnée pendant la période de transmission du logiciel, cette fonction recherche le logiciel disponible et le 
télécharge.
Le temps nécessaire au téléchargement du logiciel dépend de l'état du signal.

Mise à niveau en mode veille
Pour poursuivre la mise à jour du logiciel en gardant le téléviseur sous tension, sélectionnez ON en appuyant sur le bouton  
▲ ou ▼. Une mise à jour manuelle a lieu automatiquement 45 minutes après que l'entrée en mode veille. Étant donné que la mise 
sous tension s'effectue de façon interne, il se peut que l'écran LCD s'allume légèrement. Ce phénomène peut se produire pendant 
plus d'une heure, jusqu'à ce que la mise à jour logiciel soit terminée.
Autre logiciel
Affiche des informations sur la version du logiciel.

Guide de connexion HD
Ce menu indique la méthode de connexion offrant la qualité optimale pour le téléviseur haute définition.
Consultez ces informations lors de la connexion de périphériques externes au téléviseur.

Contacter Samsung
Consultez ces informations si le téléviseur ne fonctionne pas correctement ou si vous voulez mettre à niveau le logiciel.
Vous pouvez consulter les informations concernant le centre d'appel, le produit et la méthode de téléchargement du logiciel.

❑





N

N





❑

❑
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ANYNET+

Connexion de périphériques Anynet+
Anynet+ est une fonction qui vous permet de contrôler tous les appareils Samsung connectés compatibles Anynet+ avec votre 
télécommande Samsung.
Le système Anynet+ s'utilise uniquement avec des périphériques Samsung disposant de la fonction Anynet+. Pour vérifi er que 
votre périphérique Samsung dispose de cette fonction, assurez-vous qu'il porte le logo Anynet+.

Connexion à un téléviseur

1.  À l'aide d'un câble HDMI, reliez la prise HDMI IN (1(DVI), 2 ou 3) du téléviseur à la prise HDMI OUT du périphérique Anynet+ 
correspondant.

Connexion à un système home cinéma

1.  À l'aide d'un câble HDMI, reliez la prise HDMI IN (1(DVI), 2 ou 3) du téléviseur à la prise HDMI OUT du périphérique Anynet+ 
correspondant.

2.  À l'aide d'un câble HDMI, reliez la prise HDMI IN du système home cinéma à la prise HDMI OUT du périphérique Anynet+ 
correspondant.
Connectez le câble optique entre la prise DIGITAL AUDIO OUT (OPTICAL) de votre téléviseur et l'entrée Digital Audio (audio 
numérique) de votre système home cinéma.
Si vous suivez les instructions de connexion ci-avant, la prise optique produit uniquement un signal audio 2 voies. Vous 
n'entendrez du son qu'au niveau des haut-parleurs avant gauche et droit et du caisson de basses de votre système home 
cinéma. Pour écouter des chaînes audio 5.1, branchez la prise DIGITAL AUDIO OUT (OPTICAL) du lecteur DVD/Blu-ray ou 
du décodeur câble/récepteur satellite (c.-à-d. périphérique Anynet 1 ou 2) directement sur l'amplifi cateur ou sur un système 
home cinéma, et non sur le téléviseur.
Ne connectez qu'un seul système home cinéma.
Vous pouvez connecter un périphérique Anynet+ à l'aide du câble HDMI 1.3. Certains câbles HDMI ne prennent pas en 
charge les fonctions+
Anynet+ fonctionne si le périphérique compatible est en mode veille ou en marche.
Anynet+ prend en charge jusqu'à 12 périphériques AV. Vous pouvez connecter jusqu'à 3 périphériques du même type.

¦

N

N

N
N

N
N

TV

Câble optique

Home cinéma

Câble HDMI 1.3

Périphérique Anynet+ 1

Câble HDMI 1.3

Périphérique Anynet+ 2 Périphérique Anynet+ 3

Câble HDMI 1.3

Câble 
HDMI 1.3

TV
Périphérique Anynet+ 1

Câble HDMI 1.3

Périphérique Anynet+ 2 Périphérique Anynet+ 3

Câble HDMI 1.3
Câble HDMI 1.3
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Configuration	d'Anynet+
Appuyez sur le bouton TOOLS pour afficher le menu Outils. Vous pouvez également 
afficher le menu Anynet+ en sélectionnant Tools	→	Anynet+(HDMI-CEC).

Conf.

Anynet+(HDMI-CEC)	→	Arrêt / Marche
Pour utiliser la fonction Anynet+, l'option Anynet+ (HDMI-CEC) doit être activée.

Lorsque la fonction Anynet+ (HDMI-CEC) est désactivée, toutes les activités associées à 
Anynet+ sont désactivées.

Arrêt	automatique	→	Non	/	Oui
Extinction automatique d'un périphérique Anynet+ lorsque le téléviseur est mis hors tension

La source active sur la télécommande du téléviseur doit être définie sur TV pour pouvoir 
utiliser la fonction Anynet+
Si vous réglez Arrêt automatique sur Oui, les périphériques connectés s'éteignent 
lors de la mise hors tension du téléviseur. Toutefois, si un périphérique est en train 
d'enregistrer, il se peut qu'il ne s'éteigne pas.

Commutation entre périphériques Anynet+

1.  Appuyez sur le bouton TOOLS. Appuyez sur le bouton ENTERE pour sélectionner 
Anynet+ (HDMI-CEC).

2.  Appuyez sur le bouton ▲ ou ▼ pour sélectionner Liste d'appareils, puis appuyez sur le 
bouton ENTERE.

La liste des périphériques Anynet+ connectés au téléviseur s'affiche. Si le 
périphérique souhaité est introuvable, appuyez sur le bouton rouge pour chercher 
des périphériques.
Le menu Liste d'appareils ne s'affiche que si Anynet+ (HDMI-CEC)est activé dans 
le menu Conf..

3.  Appuyez sur le bouton ▲ ou ▼ pour sélectionner un périphérique particulier, puis appuyez sur le bouton ENTERE. Vous 
passez ainsi au périphérique sélectionné.
Le basculement vers le périphérique sélectionné peut prendre jusqu'à 2 minutes. Il est impossible d'annuler l'opération de 
basculement en cours.
Le temps de recherche nécessaire dépend du nombre de périphériques connectés.
Au terme de la recherche, le nombre de périphériques trouvés ne s'affiche pas.
Bien que le téléviseur recherche automatiquement dans la liste des périphériques lors de sa mise sous tension avec le bouton de 
marche/arrêt, les périphériques connectés au téléviseur alors que celui-ci est déjà allumé ou dans certaines autres conditions ne 
s'affichent pas automatiquement dans la liste. Appuyez sur le bouton rouge pour rechercher le périphérique connecté.
Si vous avez choisi un mode d'entrée externe en appuyant sur le bouton SOURCE, vous ne pouvez pas utiliser la fonction 
Anynet+. Veillez à basculer vers un périphérique Anynet+ à l'aide de la Liste d'appareils.

Menu Anynet+

Le menu Anynet+ varie selon le type et l'état des périphériques Anynet+ connectés au téléviseur.

MenuAnynet+ Description
Voir télévision Le mode Anynet+ change en mode de diffusion TV.
Liste d'appareils Affiche la liste des périphériques Anynet+.
MENU (nom_périphérique) Affiche les menus du périphérique connecté. Par exemple, si un graveur DVD est connecté, son 

menu de disque s'affiche.
Opération (nom_périphérique) Affiche le menu de lecture du périphérique connecté. Par exemple, si un graveur DVD est 

connecté, son menu de lecture s'affiche.
Enregistrer: (*enregistreur) Lance immédiatement l'enregistrement avec le graveur (cette fonction n'est disponible que pour 

les périphériques prenant en charge la fonction d'enregistrement).
Arrêter Enr.: (*enregistreur) Arrête l'enregistrement.
Récepteur Le son est émis par l'intermédiaire du récepteur.

Si plusieurs enregistreurs sont connectés, ils s'affichent sous la forme (*enregistreur) ; si un seul enregistreur est connecté, il 
s'affiche sous la forme (*nom_périphérique).

¦

T

❑
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N

¦
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N

N
N
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N
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Boutons de la télécommande du téléviseur disponibles en mode Anynet+

Type de 
périphérique

État de fonctionnement Boutons disponibles

Périphérique 
Anynet+

Après basculement vers le périphérique, 
lorsque son menu s'affiche à l'écran.

Touches numériques
▲/▼/◄/►/ENTERE
Boutons de couleur / Bouton EXIT

Après basculement vers le périphérique, 
pendant la lecture d'un fichier.

π(recherche vers l'arrière) / µ(recherche vers l'avant) / 
∫(Arrêter) / ∂(Lire) / ∑(Pause)

Périphérique à 
tuner intégré

Après basculement vers le périphérique, 
lorsque vous regardez un programme 
télévisé.

Bouton P > / P <

Périphérique 
audio Lorsque le récepteur est activé. Bouton Volume / MUTE

La fonction Anynet+ n'est utilisable que si la source active définie sur la télécommande est TV.
Le bouton ∏ ne fonctionne que si le périphérique est dans un état où l'enregistrement est possible.
Il est impossible de commander des périphériques Anynet+ à l'aide des boutons situés sur le téléviseur. Vous ne pouvez 
commander des périphériques Anynet+ qu'au moyen de la télécommande du téléviseur.
Il se peut que la télécommande du téléviseur ne fonctionne pas dans certaines conditions. Dans ce cas, sélectionnez de 
nouveau le périphérique Anynet+
Les fonctions d'Anynet+ n'opèrent pas sur des produits d'autres fabricants.
Les opérations π, µ peuvent varier en fonction du périphérique.

Enregistrement
Vous pouvez enregistrer un programme télévisé à l’aide d’un enregistreur Samsung.
1.  Appuyez sur le bouton TOOLS. Appuyez sur le bouton ENTERE pour sélectionner 

Anynet+ (HDMI-CEC).
2.  Appuyez sur le bouton ▲ ou ▼ pour sélectionner Enregistrer : (nom_périphérique), puis 

appuyez sur le bouton ENTERE. L'enregistrement commence.
S'il y a plusieurs périphériques d'enregistrement
Si plusieurs enregistreurs sont connectés, leur liste s'affiche. 
Appuyez sur le bouton ▲ ou ▼ pour sélectionner un périphérique, puis appuyez sur 
le bouton ENTERE. L'enregistrement commence.
Si	l’enregistreur	n’est	pas	affiché
Sélectionnez Liste d'appareils, puis appuyez sur le bouton rouge pour rechercher des périphériques.

3.  Appuyez sur le bouton EXIT pour quitter le menu.
Vous pouvez effectuer un enregistrement en sélectionnant Enregistrer : (nom_périphérique).
Appuyer sur le bouton ∫ permet d'enregistrer ce que vous regardez. Si vous regardez une vidéo provenant d'un autre 
périphérique, elle est enregistrée.
Avant d'enregistrer, vérifiez la connexion de la fiche d'antenne au périphérique d'enregistrement. Pour connecter correctement 
une antenne à un périphérique d'enregistrement, reportez-vous au mode d'emploir de ce dernier.

Écoute via un récepteur (home cinéma)
Vous pouvez écouter du son via un récepteur au lieu du haut-parleur du téléviseur.
1.  Appuyez sur le bouton TOOLS. Appuyez sur le bouton ENTERE pour sélectionner Anynet+ (HDMI-CEC).
2.  Appuyez sur le bouton ▲ ou ▼ pour sélectionner "Récepteur": Appuyez sur le bouton ◄ ou ► pour sélectionner Marche ou 

Arrêt.
3.  Appuyez sur le bouton EXIT pour quitter le menu.

Si votre récepteur ne prend en charge que l'audio, il se peut qu'il ne figure pas dans la liste des périphériques.
Le récepteur fonctionnera lorsque vous aurez correctement raccordé la fiche d'entrée optique du récepteur à la prise de sortie 
numérique (optique) DIGITAL AUDIO OUT (OPTICAL) du téléviseur.
Lorsque le récepteur home cinéma est sous tension, vous pouvez entendre du son sortant de la prise optique du téléviseur. 
Lorsque le téléviseur affiche un signal DTV (air), il envoie un son canal 5.1 au récepteur du home cinéma. Lorsque la source 
est un composant numérique (par exemple, un DVD) connecté au téléviseur TV via HDMI, le récepteur home cinéma n'émet 
qu'un son 2 voies.
Si une coupure de courant se produit alors que l'option Récepteur est définie sur Marche (câble d'alimentation débranché 
ou panne de courant), il se peut que l'option Sélection Haut-parleur soit définie sur Ht-parl ext lorsque vous rallumez le 
téléviseur (Voir page 18).

N
N
N

N

N
N

¦
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N
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N

¦

N
N
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N
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Dépannage d'Anynet+

Problème Solution possible
Anynet+ ne fonctionne pas. Vérifiez si le périphérique est compatible Anynet+. Le système Anynet+ ne prend en charge 

que les périphériques compatibles Anynet+.
Ne connectez qu'un seul récepteur (home cinéma).
Vérifiez si le cordon d'alimentation du périphérique Anynet+ est bien connecté.
Vérifiez la connexion des câbles vidéo/audio/HDMI 1.3 du périphérique Anynet+.
Vérifiez qu'Anynet+ (HDMI-CEC) est défini sur marche dans le menu de configuration 
d'Anynet+.
Vérifiez si la télécommande du téléviseur est en mode TV.
Vérifiez s'il s'agit d'une télécommande spéciale Anynet+.
Anynet+ ne fonctionne pas dans toutes les conditions. (recherche de chaînes, Plug & Play, 
etc.).
Lorsque vous branchez ou retirez le câble HDMI 1.3, veillez à relancer une recherche de 
périphérique ou à éteindre et rallumer votre téléviseur.
Vérifiez si la fonction Anynet+ du périphérique Anynet+ est activée.

●

●
●
●
●

●
●
●

●

●
Je veux démarrer Anynet+. Assurez-vous que le périphérique Anynet+ est correctement connecté au téléviseur et que la 

fonction Anynet+ (HDMI-CEC) est réglée sur Mar. dans le menu Configuration d'Anynet+.
Appuyez sur le bouton TV de la télécommande pour basculer vers le téléviseur. Appuyez 
ensuite sur le bouton TOOLS pour afficher le menu Anynet+, puis sélectionnez le menu de 
votre choix.

●

●

Je veux quitter Anynet+. Sélectionnez Voir télévision dans le menu Anynet+.
Appuyez sur le bouton SOURCE de la télécommande, puis sélectionnez un périphérique non 
compatible Anynet+
Appuyez sur P >/<, PRE-CH et FAV.CH pour modifier le mode TV. (remarque : le bouton 
de chaîne ne fonctionne que si aucun périphérique Anynet+ à tuner intégré n'est connecté).

●
●

●

Le message "Connexion à 
Anynet+" s'affiche à l'écran.

Il est impossible d'employer la télécommande pendant la configuration d'Anynet+ ou le 
basculement en mode de visualisation.
La télécommande n'est utilisable qu'au terme de la configuration d'Anynet+ ou du 
basculement en mode de visualisation.

●

●

Le périphérique Anynet+ ne 
lit pas.

Vous ne pouvez pas utiliser la fonction de lecture quand une opération Plug & Play est en 
cours.

●

Le périphérique connecté ne 
s'affiche pas.

Vérifiez si le périphérique prend en charge les fonctions Anynet+.
Vérifiez si le câble HDMI 1.3 est correctement connecté.
Vérifiez si Anynet+ (HDMI-CEC) est réglé sur Mar. dans le menu de configuration Anynet+.
Lancez une nouvelle recherche de périphériques Anynet+.
Vous ne pouvez connecter un périphérique Anynet+ qu'à l'aide d'un câble HDMI 1.3. Certains 
câbles HDMI ne prennent pas en charge les fonctions+
En cas d'arrêt anormal résultant d'une déconnexion du câble HDMI ou du câble d'alimentation, 
ou encore d'une panne de courant, effectuez une nouvelle recherche de périphériques.

●
●
●
●
●

●

Impossible d'enregistrer le 
programme TV.

Vérifiez que la fiche d'antenne est correctement branchée sur le périphérique 
d'enregistrement.

●

Le son du téléviseur ne sort 
pas par le récepteur.

Reliez le téléviseur au récepteur à l'aide du câble optique.●

¦
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RECOMMANDATION D'UTILISATION

Fonction Télétexte
La plupart des chaînes de télévision offrent des services d'informations écrites via le télétexte. La page d'index du télétexte 
contient des instructions sur l'utilisation du service. Vous pouvez, en outre, sélectionner différentes options à l'aide des touches de 
la télécommande.

Pour que les informations du télétexte s'affichent correctement, la réception des chaînes doit être stable. Autrement, des 
informations pourraient manquer ou certaines pages ne pas s'afficher.  
Vous pouvez changer de page de télétexte en appuyant sur les touches numériques de la télécommande.

1 0 (mode)
Permet de sélectionner le mode 
Télétexte (LIST/FLOF). Si vous appuyez 
sur cette touche en mode LISTE, vous 
basculez en mode d'enregistrement 
de liste. Dans ce mode, vous pouvez 
enregistrer une page de télétexte dans 
une liste à l'aide du bouton  
8 (mémoriser).

2 5 (révéler)
Permet d'afficher le texte masqué 
(par exemple, les réponses à un 
questionnaire). Pour rétablir le mode 
d'affichage normal, appuyez de 
nouveaux dessus.

3 4 (taille)
Permet d'afficher la moitié supérieure 
de l'écran en caractères deux fois plus 
grands. Pour afficher la moitié inférieure 
de l'écran, appuyez de nouveau sur 
cette touche. Pour rétablir le mode 
d'affichage normal, appuyez dessus une 
fois de plus.

4 8 (mémoriser)
Permet d'enregistrer les pages de 
télétexte.

5 Boutons de couleur (rouge/vert/jaune/
bleu)
Si une société de télédiffusion utilise 
le système FASTEXT, les différentes 
rubriques d'une page de télétexte 
sont associées à un code couleur 
qui permet de les sélectionner à 
l'aide des touches de couleur de 
la télécommande. Appuyez sur la 
touche dont la couleur correspond 
à celle de la rubrique souhaitée. La 
page affiche d'autres informations en 
couleur que vous pouvez sélectionner 
de la même manière. Pour afficher la 
page précédente ou la page suivante, 
appuyez sur la touche de couleur 
correspondante.

6 / (télétexte actif/mixte)
Permet d'activer le mode Télétexte après 
avoir choisi la chaîne diffusant le service 
télétexte. Appuyez deux fois sur cette 
touche pour superposer le télétexte à 
l'émission en cours de diffusion.

7 : (quitter)
Quitte l'affichage du télétexte.

8 1 (page secondaire)
Permet d'afficher une page secondaire.

9 2 (page suivante)
Permet d'afficher la page de télétexte 
suivante.

0 3 (page précédente)
Permet d'afficher la page de télétexte 
précédente.

! 6 (index)
Permet d'afficher la page d'index du 
télétexte (sommaire) à tout moment.

@ 9 (verrouiller)
Permet de bloquer l'affichage sur une 
page précise, si celle-ci est reliée à 
plusieurs pages secondaires qui défilent 
automatiquement. Pour reprendre 
l'affichage de celles-ci, appuyez de 
nouveau sur cette touche.

# 7 (annuler)
Permet d'afficher le programme lors de la 
recherche d'une page.

Les pages de télétexte sont organisées en six catégories :

Catégorie Contenu
A Numéro de la page sélectionnée.
B Identité de la chaîne émettrice.
C Numéro de la page actuelle ou indications de recherche.
D Date et heure.
E Texte.
F Informations sur l'état.

Informations FASTEXT.

¦

N

N
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Les informations du télétexte sont souvent réparties sur plusieurs pages qui s'affichent successivement. Ces pages sont 
accessibles en :

entrant le numéro de page ;
sélectionnant un titre dans une liste ;
sélectionnant un titre de couleur (système FASTEXT).

Le téléviseur prend en charge le niveau de télétexte 2.5 qui peut afficher des graphiques ou textes supplémentaires.
En fonction de la transmission, des panneaux latéraux vides peuvent apparaître lors de l'affichage du télétexte.
Dans ce cas, les graphiques ou textes supplémentaires ne sont pas transmis.
Les téléviseurs plus anciens qui ne prennent pas en charge la version 2.5 ne peuvent pas afficher les graphiques et textes 
supplémentaires, indépendamment de la transmission télétexte.
Appuyez sur le bouton TV pour quitter l'affichage du télétexte.
Télétexte 16:9 - Format d'image 16:9

Montage du socle

Préréglage: Placez le support du guide et le goulot du couvercle sur le socle et fixezles à 
l’aide des vis. Uniquement applicable aux modèles 32 pouces.

N

1. Fixez le téléviseur LCD sur le socle.
Le téléviseur doit être porté par au moins deux personnes.
Veillez à bien faire la distinction entre l'avant et l'arrière du socle lors de l'assemblage.
Pour être certain d'installer le téléviseur sur son socle au niveau approprié, n'exercez 
pas de pression vers le bas excessive sur ses côtés supérieurs gauche et droit.

2. Insérez deux vis dans l'emplacement 1, puis deux autres dans l'emplacement 2.
Redressez le produit et serrez les vis. Si vous serrez les vis tandis que le téléviseur 
LCD est couché, il se peut qu'il penche d'un côté.

N
N
N

N

Installation du kit de montage mural

Des éléments de montage mural (vendus séparément) permettent de fixer le téléviseur au 
mur.
Pour plus d'informations sur l'installation du support mural, reportez-vous aux instructions 
fournies avec les éléments de montage mural. Faites appel à un technicien pour vous aider à 
installer le support mural.
Samsung Electronics ne saurait être tenu pour responsable d'un endommagement du produit 
ou d'une blessure si vous choisissez d'effectuer vous-même l'installation murale.

N'installez pas le kit de montage mural lorsque le téléviseur est sous tension. Cela 
pourrait entraîner une blessure par choc électrique.

N

–
–
–

N
N
N
N
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¦
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Utilisation du verrou antivol Kensington

Le verrou Kensington est un dispositif utilisé pour fixer physiquement le système en cas 
d'utilisation dans un lieu public. L'aspect du verrou et la méthode de verrouillage peuvent 
différer de l'illustration en fonction du fabricant. Consultez le manuel fourni avec le verrou 
Kensington pour savoir comment l'utiliser correctement. Le dispositif de verrouillage est 
vendu séparément. L'emplacement du verrou Kensington peut varier en fonction du modèle.
1. Insérez le dispositif de verrouillage dans le logement Kensington du téléviseur LCD (1), 

puis tournez-le dans le sens de verrouillage (2).
2. Branchez le câble du verrou Kensington (3).
3. Fixez le câble du verrou Kensington sur un bureau ou tout autre objet lourd inamovible.

3

1

2

Sécurisation de l'emplacement d'installation
Respectez les distances requises entre le produit et d'autres objets (p. ex. murs) pour assurer une ventilation adéquate. 
Le non-respect de cette consigne pourrait provoquer un incendie ou un problème avec le produit en raison de l'augmentation de la 
température interne de ce dernier.
Installez le produit de manière à respecter les distances requises indiquées sur la figure.

En cas d'utilisation d'un support ou de montage mural, n'utilisez que des pièces Samsung Electronics.
L'emploi de pièces d'un autre fabricant risque d'entraîner des problèmes avec le produit ou d'occasionner des blessures 
dues à la chute du produit.
L'emploi de pièces d'un autre fabricant risque d'entraîner un problème avec le produit ou de provoquer un incendie en 
raison de l'augmentation de la température interne du produit due à une ventilation insuffisante.

L'aspect peut varier en fonction du produit.

Installation du produit sur un support Montage mural du produit

10 cm

10 cm

10 cm

10 cm

10 cm10 cm

10 cm

¦

¦

N
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Fixation du téléviseur au mur

Attention : Si vous tirez ou poussez le téléviseur ou si vous grimpez dessus, il risque de tomber. Veillez en 
particulier, à ce que vos enfants ne se suspendent pas au téléviseur, ni ne le déséquilibrent, car cela pourrait le 
faire basculer et occasionner des blessures graves pouvant entraîner la mort. Respectez toutes les précautions 
de sécurité indiquées dans la brochure relative à la sécurité. Pour une stabilité accrue, installez le dispositif 
antichute comme indiqué ci-après.

Pour éviter toute chute du téléviseur :
1. Glissez les vis dans les colliers, puis fixez-les solidement au mur. Assurez-vous que les 

vis sont solidement fixées au mur.
En fonction du type de mur, il est possible que vous ayez besoin de matériel 
supplémentaire, tel que des chevilles.
Les colliers, vis et chaînettes n'étant pas fournis, vous devez les acheter 
séparément.

2. Retirez les vis situées sur la partie centrale arrière du téléviseur, glissez-les dans les 
colliers, puis fixez-les de nouveau sur le téléviseur.

Il est possible que les vis ne soient pas fournies avec le produit. Dans ce cas, 
achetez des vis présentant les caractéristiques suivantes. 
Caractéristiques des vis
Pour un téléviseur LCD 17 à 29 pouces : M4 X L15 / Pour un téléviseur LCD 32 à 
40 pouces : M6 X L15

3. Reliez les bagues fixées au téléviseur et celles fixées sur le mur à l'aide de chaînettes, 
puis attachez-les fermement.

Placez le téléviseur à proximité du mur afin qu'il ne bascule pas vers l'arrière.
Il est recommandé de placer la chaînette de façon à ce que les colliers fixés au mur 
soient placés à même hauteur ou plus bas que ceux fixés au téléviseur.
Détachez la chaînette avant de déplacer le téléviseur.

4. Vérifiez que toutes les connexions sont fixées correctement. Vérifiez régulièrement que 
les connexions ne présentent aucun signe d'usure. Si vous avez un doute quant à la 
sécurité des connexions, contactez un installateur professionnel.

¦
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Dépannage
Si vous avez des questions relatives au téléviseur, commencez par consulter la liste ci-dessous. Si aucune de ces astuces de 
dépannage ne s'applique à votre problème, rendez-vous sur le site ‘www.samsung.com’, puis cliquez sur Support ou contactez le 
centre d'appel dont les coordonnées figurent sur la dernière page.

Problème Solution

Qualité de l'image

Exécutez tout d'abord le Test de l'image pour vérifier que votre téléviseur affiche correctement 
l'image de test.

Accédez à MENU - Assistance - Diagnostic automatique - Test de l'image
Si l'image de test s'affiche correctement, sa qualité médiocre peut être due à la source ou au signal.
●

La qualité de l'image sur le 
téléviseur n'est pas aussi 
bonne que dans le magasin.

Si vous êtes équipé d'un décodeur câble/boîtier décodeur analogique, procédez à une mise à 
niveau. Utilisez les câbles HDMI ou Composant pour fournir une qualité d'image HD.
Abonné câble/satellite : essayez les chaînes HD (High Definition) à partir de l'alignement des canaux.
Connexion de l'antenne : essayez les chaînes HD après avoir exécuté une mémorisation 
automatique.

De nombreuses chaînes HD sont mises à niveaux par rapport à du contenu  
SD (Standard Definition).

Réglez la résolution de sortie vidéo du décodeur câble/boîtier décodeur sur 1080i ou 720p.
Veillez à respecter la distance minimale recommandée entre vous et le téléviseur (distance 
basée sur la taille et la définition du signal affiché).

●

●
●

N

●
●

L'image est déformée : 
macrobloc, petit bloc, points, 
pixelisation

La compression de contenus vidéo peut engendrer une déformation de l'image, en 
particulier pour les mouvements rapides comme le sport et les films d'action.
Un niveau de signal faible ou une mauvaise qualité peut déformer l'image. Il ne s'agit pas 
d'un problème lié au téléviseur.

●

●

Couleur incorrecte ou 
manquante avec la 
connexion Composant.

Vérifiez que les câbles Composant sont raccordés aux prises appropriées. Des 
raccordements desserrés ou incorrects peuvent engendrer des problèmes au niveau de la 
couleur ou de l'écran (vide).

●

Luminosité ou couleur 
médiocre.

Réglez les options Image dans le menu du téléviseur (mode Image, Couleur, Luminosité, 
Netteté).
Réglez l'option Mode éco. dans le menu Configuration.
Essayez de réinitialiser l'image pour afficher son paramètre par défaut  
(accédez à MENU - Image - Réinitialisation de l'image).

●

●
●

Ligne pointillée sur le bord 
de l'écran.

Si la taille de l'image est réglée sur Adapter à l'écran, remplacez la valeur par 16:9.
Changez la résolution du décodeur câble/boîtier décodeur.

●
●

L'image est en noir et 
blanc avec l'entrée AV 
(Composite) uniquement.

Raccordez le câble vidéo (jaune) à la prise verte de l'entrée Composant 1 du téléviseur.●

L'image se fige ou est 
déformée lorsque vous 
changez de chaînes ou l'image 
s'affiche avec un décalage.

En cas de raccordement avec le décodeur câble, essayez de réinitialiser ce dernier 
(rebranchez le cordon d'alimentation secteur et patientez jusqu'au démarrage du décodeur 
câble. Cette opération peut durer jusqu'à 20 minutes).
Réglez la résolution de sortie du décodeur câble sur 1080i ou 720p.

●

●

Qualité sonore

Exécutez tout d'abord le Test du son pour vérifier que le système audio de votre téléviseur 
fonctionne correctement.

Accédez à MENU - Assistance - Diagnostic automatique - Test du son
Si le système audio fonctionne correctement, le problème lié au son peut provenir de la source ou du signal.
●

Aucun son ou son trop faible 
lorsque le niveau du volume 
est au maximum.

Vérifiez le volume du périphérique externe connecté à votre téléviseur, puis réglez le volume 
du téléviseur en conséquence.

●

Image correcte mais 
absence de son.

Réglez l'option Sélection Haut-parleur sur Haut-parleur TV dans le menu Sound.
Vérifiez que les câbles audio d'un périphérique externe sont raccordés aux prises d'entrée 
audio appropriées du téléviseur. 
Vérifiez l'option de sortie audio du périphérique connecté (par exemple : il se peut que vous deviez 
remplacer l'option audio de votre décodeur câble par HDMI si vous utilisez la connexion HDMI).
Si vous utilisez un câble DVI-HDMI, un câble audio distinct est requis.
Désactivez la fonction SRS si le réglage du volume est supérieur à 30.
Retirez la fiche de la prise pour casque (si disponible sur votre téléviseur).

●
●

●

●
●
●

Bruit émis par le  
haut-parleur.

Vérifiez le raccordement des câbles. Vérifiez qu'aucun câble vidéo n'est raccordé à une entrée audio.
Pour la connexion de l'antenne/du câble, vérifiez l'intensité du signal. Un niveau de signal 
faible peut provoquer une distorsion sonore.

●
●

¦
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Problème Solution
Aucune image, aucune 

vidéo
Le téléviseur ne s'allume 
pas.

Vérifiez que le cordon d'alimentation secteur est branché correctement dans la prise murale 
et sur le téléviseur.
Vérifiez que la prise murale est opérationnelle.
Essayez d'appuyer sur le bouton POWER du téléviseur pour vérifier que la télécommande 
fonctionne correctement. Si le téléviseur s'allume, la télécommande peut être à l'origine de 
cette mise sous tension. Pour résoudre le problème lié à la télécommande, reportez-vous au 
problème ‘La télécommande ne fonctionne pas’ ci-après.

●

●
●

Le téléviseur s'éteint 
automatiquement.

Vérifiez que la fonction Veille  est réglée sur Marche dans le menu Configuration.
Si vous connectez le téléviseur à votre PC, vérifiez les paramètres d'alimentation de votre 
PC.
Vérifiez que le cordon d'alimentation secteur est branché correctement dans la prise murale 
et sur le téléviseur.
En l'absence de signal pendant environ 10 à 15 minutes avec la connexion Antenne/câble, 
le téléviseur s'éteint.

●
●

●

●

Aucune image/vidéo. Vérifiez le raccordement des câbles (retirez tous les câbles du téléviseur et des 
périphériques externes et rebranchez-les).
Réglez la sortie vidéo de votre périphérique externe (décodeur câble/boîtier décodeur, DVD, 
Blu-ray, etc.) pour faire correspondre les connexions à l'entrée du téléviseur. Par exemple, 
sortie du périphérique externe : HDMI, entrée du téléviseur : HDMI.
Vérifiez que votre périphérique connecté est sous tension.
Veillez à sélectionner la source appropriée du téléviseur en appuyant sur le bouton 
SOURCE de la télécommande.

●

●

●
●

Connexion RF  
(câble/antenne)

Impossible de recevoir 
toutes les chaînes.

Vérifiez que le câble de l'antenne est raccordé correctement.
Essayez la fonction Plug & Play pour ajouter des chaînes disponibles à la liste 
correspondante. Accédez à MENU - Configuration - Plug & Play et attendez que toutes les 
chaînes disponibles soient mémorisées.
Vérifiez que l'antenne est positionnée correctement.

●
●

●
L'image est déformée : 
macrobloc, petit bloc, points, 
pixelisation

La compression de contenus vidéo peut engendrer une déformation de l'image, en 
particulier pour les mouvements rapides comme le sport et les films d'action.
Un niveau de signal faible peut déformer l'image. Il ne s'agit pas d'un problème lié au 
téléviseur.

●

●

Connexion PC
Message ‘Mode non pris en 
charge’.

Réglez la fréquence et la résolution de sortie de votre PC de sorte à ce qu'il corresponde 
aux résolutions prises en charge par le téléviseur.

●

Le PC apparaît toujours 
dans la liste source même 
s'il n'est pas connecté.

C'est normal ; le PC apparaît toujours dans la liste source même s'il n'est pas connecté.●

La vidéo fonctionne 
correctement mais le 
système audio n'existe pas 
avec une connexion HDMI.

Vérifiez le paramètre de sortie audio de votre PC.●
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Problème Solution
Autres

L'image ne s'affiche pas en 
plein écran.

Des barres noires s'affichent de chaque côté des chaînes HD lors de l'affichage du contenu 
SD étendu (4:3).
Des barres noires s'affichent en haut et en bas des films dont le format est différent de celui 
de votre téléviseur.
Réglez l'option de la taille de l'image sur votre périphérique externe ou le téléviseur en plein 
écran.

●

●

●

La télécommande ne 
fonctionne pas.

Replacez les piles de la télécommande en respectant la polarité (+ -).
Nettoyez la lentille de la télécommande située en haut de la télécommande.
Essayez de diriger directement la télécommande vers le téléviseur dans un rayon de 1,5 à 
1,8 m.

●
●
●

Impossible de contrôler 
l'alimentation ou le volume 
du téléviseur avec la 
télécommande du décodeur 
câble/boîtier décodeur.

Programmez la télécommande du décodeur câble/boîtier décodeur pour faire fonctionner le 
téléviseur. Consultez le manuel de l'utilisateur relatif au câble/satellite pour obtenir le code 
du téléviseur SAMSUNG.

●

Message ‘Mode non pris en 
charge’.

Vérifiez la résolution prise en charge du téléviseur et réglez la résolution de sortie du 
périphérique externe en conséquence. Reportez-vous aux paramètres de résolution 
indiqués dans ce manuel.

●

Odeur de plastique émise 
par le téléviseur.

Cette odeur est normale et s'atténuera au fur et à mesure.●

Informations de signal 
du téléviseur n'est pas 
disponible dans le menu 
de test du diagnostic 
automatique.

Cette fonction n'est disponible qu'avec des chaînes numériques avec connexion d'antenne 
(RF/coaxial).

●

Le téléviseur penche vers la 
droite ou la gauche.

Retirez la base du support du téléviseur et réassemblez-la.●

Impossible d'assembler la 
base du support.

Veillez à placer le téléviseur sur une surface plane. Si vous ne parvenez pas à retirer les vis 
du téléviseur, utilisez un tournevis aimanté.

●

Le menu des chaînes est 
grisé (non disponible).

Le menu Canal n’est disponible que si la source du téléviseur est sélectionnée.●

Vos paramètres sont perdus 
après 30 minutes ou à 
chaque mise hors tension 
du téléviseur.

Si le téléviseur est en mode Enr. démo, les paramètres de l'image et audio sont rétablis 
toutes les 30 minutes. Remplacez le mode Enr. démo par le mode Util. domicile  dans la 
procédure Plug & Play. Appuyez sur le bouton SOURCE pour sélectionner le mode TV, 
accédez à MENU → Configuration → Plug & Play → ENTERE.

●

Perte intermittente du signal 
audio ou vidéo.

Vérifiez le raccordement des câbles ; raccordez-les au besoin. 
Cette perte peut être provoquée par l'utilisation de câbles trop rigides ou épais. Veillez à 
ce que les câbles soient suffisamment souples pour une utilisation à long terme. En cas 
d'installation murale, nous vous recommandons d'utiliser des câbles avec des connecteurs 
de 90 degrés.

●
●

Il se peut que vous voyiez 
de petites particules si vous 
regardez de près le bord du 
cadre de l'écran du téléviseur.

Elles font partie de la conception du produit et ne constituent pas un défaut.●

‘Signal brouillé’ ou ‘Aucun 
signal/signal faible’ avec la 
carte d’interface (CI) CARD 
du CAM.

Vérifiez que la carte d'interface commune CI CARD est installée dans le CAM dans la fente 
de l'interface commune.
Tirez le CAM du téléviseur et insérez-le de nouveau dans la fente.

●

●

45 minutes après sa mise 
hors tension, le téléviseur 
s'allume.

Cela est normal car le téléviseur utilise la fonction de liaison radio (OTA) pour mettre à 
niveau le microprogramme téléchargé pendant son utilisation.

●

Problème récurrent lié à 
l'image/au son.

Vérifiez et changez le signal/la source.●

Ce téléviseur LCD TFT est équipé d'un écran constitué de sous-pixels dont la fabrication nécessite une technologie 
sophistiquée. Il se peut toutefois que des points clairs ou sombres apparaissent à l'écran. Ceux-ci n'ont aucune incidence sur 
les performances du produit.

N
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Caractéristiques

Nom du modèle LE3�B530 LE40B530 LE46B530
Taille de l'écran 
(diagonale) 37 pouces 40 pouces 46 pouces
Résolution du PC
(optimale) 1920 x 1080 à 60 Hz 1920 x 1080 à 60 Hz 1920 x 1080 à 60 Hz
Son
(Sortie) 10 W x 2 10 W x 2 10 W x 2
Dimensions (LxPxH)
Corps
Avec socle

918 X 77 X 597 mm
918 X 300 X 650 mm

998 X 78 X 621 mm
998 X 260 X 686 mm

1127 X 78 X 712 mm
1127 X 260 X 766 mm

Poids
Avec socle 15 kg 18 kg 24 kg
Considérations environnementales
Température de fonctionnement
Humidité en cours de fonctionnement
Température de stockage
Humidité sur le lieu de stockage

10°C à 40°C (50°F à 104°F)
10 % à 80 %, sans condensation

-20°C à 45°C (-4°F à 113°F)
5 % à 95 %, sans condensation

Socle orientable
Gauche / droite -20˚ ~ 20˚

La conception et les spécifications peuvent être modifiées sans préavis.
Ce périphérique est un appareil numérique de classe B.
Concernant l'alimentation et la consommation électrique, reportez-vous à l'étiquette apposée sur le produit.

¦

N
N
N
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